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Introduction 
Thank you for purchasing AutoPilot. 

AutoPilot’s 64-bit architecture enables multi-site, PC-based facilities management for the entire line of 

Burk remote controls, including ARC Plus, ARC Solo, ARC-16, GSC3000 and VRC2500. AutoPilot's fully 

customizable interface makes managing remote sites easy for operators, engineers and managers. 

Built-in reports are easily tailored to individual needs, and can be printed automatically or emailed as a 

PDF to station personnel. AutoPilot also includes network management functionality, bridging the gap 

between broadcast and IT by including SNMP and ping with traditional I/O. 

With AutoPilot, you can: 

• Monitor and control ARC Plus, ARC Solo, ARC-16, GSC3000, and VRC2500 sites in real-time.  

• Automatically log site parameters using the onboard log or Microsoft SQL Server.  

• Automatically print or email reports to station personnel.  

• Build custom screens to tailor the software to your exact needs.  

• Manage network devices using SNMP and ping.  

To configure the onboard parameters for your remote control, please use the appropriate configuration 

tool: 

ARC Plus AutoLoad Plus 
ARC Solo Web Page 
ARC-16 AutoLoad 
GSC/VRC AutoLoad GSC 

 

For more information, visit www.burk.com. 

 

Read the Getting Started section (PAGE 2) for help setting up AutoPilot for the first time. To get the 

most out of the AutoPilot software, see the In Depth section. For detailed information about specific 

topics, see the Reference section (PAGE 101). 

What happened to AutoPilot 2010? 
Burk Technology registered the AutoPilot trademark 25 years ago for the DOS based program to 
use with ARC-16s. The product evolved , culminating in a universal version which carried the 2010 
suffix. We continue to refine the product as part of our Continuous Improvement program, and 
have chosen to return to the original brand name, differentiating releases only by revision number. 
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Getting Started 

Overview 

Working with Docking Windows 

Moving Docking Windows 

The position of each toolbar can be changed by clicking on the title area and dragging it. The toolbars 

can be undocked into a floating window, or docked to the top, bottom, and sides of the screen. 

Dropping one toolbar on top of another combines the two into the same space, allowing selection of 

one toolbar at a time with tabs. To separate tabbed toolbars, click and hold the tab and drag away from 

the toolbar.  

Auto Hide 

 Docking windows have an auto hide feature, allowing them to disappear from view when 

unneeded to maximize the available screen space for monitoring and control.  

To turn auto hide on or off, click the pushpin icon in the upper right of a toolbar’s title bar. A vertical 

pushpin indicates that auto hide is off and the toolbar is locked into place until you move it or turn auto 

hide on. A horizontal pushpin means auto hide is on. When you remove the mouse from the toolbar 

area, the toolbar will collapse into a tab on the perimeter of the screen. To display the toolbar again, 

simply move your mouse over the tab. 

Auto hide does not close the windows – they collapse into tabs on the sides or bottom (depending on 

docked location) of the AutoPilot Plus window. To have the window reappear, simply move your mouse 

over the tab. This causes the window to expand, allowing you to use it. To hide the window again, move 

the mouse away from the window and it will collapse after a few seconds.  

When Auto Hide is enabled, clicking the window’s title area or icon tab will lock focus on the window, 

and the toolbar will not hide again until you click a different area in the program to change focus. 

Reset Docking Windows 

The function key F10 is mapped to the reset windows that have been docked. This option is also in the 

View menu of AutoPilot. 
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 Resources 

The Resources window (known as the Navigator in versions prior to 

2.10.47)  is the main tool used for selecting items to work with in 

AutoPilot. The Resources window shows your sites (including ARC Plus, 

ARC Solo, ARC-16, and GSC3000/VRC2500), Network Devices, Custom 

Views, and Reports. 

To view an item, click on its icon. By default, Reports require a double-

click to open. You can change this behavior in the Options dialog. 

Each item in the Resources window has a context menu, accessed by a 

right-click, that shows a list of actions that can be performed on that 

item. 

By default, the Resources window is docked to the left hand side of the screen. You can move, hide, or 

close the window to suit your needs. 

New items (sites, network devices,custom views, etc.) are created in the Resources window. Once 

created, these items are available to drag into the Navigator to group them into categorized views that 

you define, as described in the next section. To completely delete an item, delete it from the Resources 

window.  

Navigator 

The new Navigator lets you organize items from the Resources window into groups. Using a 

hierarchical network view, similar to a Windows-style file system, you can create new folders and drag 

in sites, custom views and reports from the Resources window wherever you like.  

These groupings make it easy for you to view your site data in a way that is meaningful to you. For 

example, you could group all stations managed by a certain engineer together or put all AM stations in 

one group, all FM stations in a second group and all TV stations in a third group. Or you could create 

regional groups for east coast, central and west coast, with subgroupings by market.  

Create as many views within the Navigator as you like. Multiple copies of sites, custom views and 

reports can be displayed in the Navigator, giving you complete flexibility in displaying your assets. The 

original, underlying data remains unchanged and is displayed in the Resources window. 

To completely delete an item, delete it from the Resources window. All instances of the item are 

automatically removed from the Navigator.The Navigator starts out unpopulated.  
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Unpopulated Navigator 

To create a network topology within the Navigator, add new folders and drag sites, network devices, 

custom views, and reports from the Resources window. You can nest folders within folders to create 

hierarchies.  

Note: You can drag ARC Plus and ARC Solo sites into the Navigator. Legacy sites (for example, ARC 

16 or GSC3000 sites) must be accessed in the Resources window. 

In this example, the main folder, FM Stations, contains a Boston Stations subfolder. The WGDH FM 

station sites and Custom Views are copied into the Navigator’s Boston Stations folder. 
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Copies of Items Dragged from Resources Window to Navigator 

Resources Tool Tips 

Tool tips are available for most Resources window and Navigator icons. Hover over an icon to see more 

information about it. 

 

Navigator Tool Tip 
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Default Views 

AutoPilot can display a Default View for each site without any additional configuration. To open a 

default view, click on the site's icon in the Resources window or Navigator. The Default View will show 

all of the channels on the selected site, using the labels and colors configured for the site. 

Opening Default Views with a single click can be disabled in the Options dialog. To open a default view 

when this is the case, double-click on the site or right-click and select "Default View". 

Default Views may also be opened in a new window by right-clicking on the site and selecting "Default 

View in New Window". 

ARC Plus Channel Banks 

ARC Plus sites will also show a "channel bank" selector, breaking up the site in 16 channel pages. To 

view a different bank of channels, select the desired range from the drop-down list, or use the 

navigation buttons.  

 

Channel bank selector for ARC Plus sites 

Default View Display Modes 

AutoPilot offers three types of default views: Graphical, Grid, and Log View. To select a display mode, 

use the drop-down in the Default View tool bar.  

 

Display Mode Selector 
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Graphical View 

The Graphical View is the primary Default View. The Graphical View displays site data using realistic 

analog gauges and LEDs. Each type of remote control (ARC Plus, ARC Solo, ARC-16, and 

GSC3000/VRC2500) has a different Graphical View.  

 

ARC Plus Graphical View 

Grid View 

The Grid View displays all of the site's channels in a three-pane grid (metering, status, and commands). 

Warning conditions are highlighted in yellow and critical conditions in red. This allows an operator to 

quickly assess site conditions, and maximizes the amount of data that can be easily read on one page.  

 

Grid View 

Logged Data View 

The Logged Data View shows the site data that AutoPilot has captured and/or logged, (including 

telemetry, status conditions, alarms, and events). This view allows easy access to the log without 

needing to run a report. There are several options that control the behavior of the log view: 

Options 

Date Range AutoPilot can show the most recent data limited by a number of days, or all of the 
data in a specific date range.  

Messages The Log View always shows telemetry. Additionally, AutoPilot can include status 
conditions, alarms, and events.   
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Logged Data View 

 Custom Views Overview 

Custom Views allow you to completely customize the look and feel of AutoPilot to suit your needs. For 

more information about creating Custom Views, read Creating Custom Views. 

Custom Views offer a wide variety of onscreen components to display site data. Custom Views can 

include any number of channels of any type, from multiple sites (even using different models of remote 

control).  

Popular uses of Custom Views include: 

• Interfaces specifically designed for operators, engineers, managers, etc.  

• Summary screens showing high-level site data from multiple sites.  

• "Drill-down" interfaces allowing users to click on status indicators to learn more about alarm 

conditions.  

• Map views to show status indicators on state, regional, or national maps, corresponding with 

the location of the site.  

To open a Custom View, click on the desired view in the Resources window or Navigator (Custom Views 

appear in the "Custom Views" folder in the Resources window). Note that single-clicking to open a 

Custom View can be disabled in the Options dialog. If this is the case, double-click on the Custom View, 

or right-click and select "Show View". 

To open a Custom View in a new Window, right-click on the Custom View in the Resources or Navigator 

window and select "Show View in New Window". 

Note: You can open a Custom View outside of AutoPilot by double-clicking the Custom View file in 

Windows. 

Linking Sites to Custom Views 

To use a Custom View instead of the Default View for a site, right-click on the site in the Resources 

window or Navigator and select "Link Custom View". AutoPilot will prompt you for the desired Custom 

View file. Once you have linked a site to a Custom View, clicking on the site in the Resources window or 

Navigator will open the Custom View instead of the Default View. 
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To restore the default behavior, right-click on the site and select "Unlink Custom View".  

Note: You can still access a Default View for a site when linked to a Custom View by right-clicking on 

the site and selecting "Default View". 

 Reports Overview  

AutoPilot Reports all you to format and print/display your logged 

data from one or more sites. Reports can be viewed onscreen, 

printed to paper, or saved as a PDF file. AutoPilot can automatically 

print a report on a regular basis, as well as automatically email a 

PDF of the report to one or more email addresses. 

A Report in AutoPilot is a template, describing what data should be 

included and how it should look. Whenever you run a report, 

AutoPilot pulls the appropriate data from the database. Once you 

have created your Report, you can run it as often as needed, and do 

not need to edit it to update your data. 

To learn how to create a report, read Creating Reports (SEE PAGE 

45). 

Running Reports 

To run a report, you can print it directly, or view a print preview (either in AutoPilot's main window or in 

a new window). The print preview display also allows you to save to PDF. 

 

"Save to PDF" from the Print Preview window 

Note: AutoPilot requires that you have a default printer selected in Windows to run a report - even if 

you are not printing to paper. If you do not have a printer installed, you can add a printer to Windows 

even if one is not connected to your computer. 

To print directly, select the Report in the Resources window or Navigator and select "Print..." from the 

File menu. 

To run a print preview, select the Report in the Resources window or Navigator and select "Print 

Preview" from the File menu. You can also simply double-click on the Report in the Resources window 

or Navigator. 

To open a print preview in a new window, select the Report in the Resources window or Navigator and 

select "Print Preview in New Window" from the File menu. 
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Note: If desired, you can set AutoPilot to automatically open a print preview when you select a 

Report in the Resources window or Navigator. To enable this feature, access it from the Options 

dialog. 

Alarms Overview 

Alarms are generated by the remote control and reported to AutoPilot either via an existing connection 

or dialup call. Any time an alarm is received, AutoPilot logs the alarm to the database – even if logging 

is disabled. 

 

Terminology 

Active Alarm  An alarm whose channel is presently still in an alarm state is active.  

Inactive Alarm  An alarm whose channel is no longer in an alarm state is inactive.  

Incidental Alarm  If an alarm does not have a state that will cause it to become inactive, it is an 
incidental alarm.  

Cleared Alarm  An alarm can be cleared by a user running AutoPilot, or by another source 
(such as a Web Interface user).  

System Alarm  A system alarm is generated by the remote control to indicate an internal 
error or problem.  

Duplicate Alarm  An alarm is a duplicate if it has the same source channel as another alarm.  

Root Alarm  A root alarm is an alarm caused by a condition that may also cause one or 
more other (subordinate) alarms.  

Subordinate Alarm  A subordinate alarm is an alarm caused by a chain reaction resulting from a 
different condition (a root alarm).  

Alarm Severity  Alarms are either warning or critical conditions. AutoPilot displays the alarm 
severity, and uses it to color code alarms in Reports.  

Alarm Priority  Alarm priority is a numeric value assigned to an alarm condition to help an 
AutoPilot user determine which alarms are the most or least important.  

 

The Alarm List 

The Alarm List displays all alarms on all currently connected sites. By default, the Alarm List is docked 

on the bottom of the screen. This is the primary means by which AutoPilot displays alarm information, 

and allows you to clear alarm conditions. 

 

Alarm List 
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Tool Bar Buttons 

The Alarm List has its own tool bar, allowing you to clear one or more alarms and change how alarms 

are displayed. 

 Clear All Alarms Clears every alarms in the Alarm List.  

 Clear Selected Alarms Clears the icon or icons that are current selected in the Alarm List.  

 Show Cleared Alarms When "Show Cleared Alarms" is enabled, the Alarm List will include 
alarms that have already been cleared. Cleared alarms are show in 
gray, italicized text.  

 Show Active Alarms Only When "Show Active Alarms Only" is enabled, the Alarm List will 
only show "active" alarms.  

 Show Duplicate Alarms When "Show Duplicate Alarms" is enabled, the Alarm List will show 
every instance of an alarm. When not enabled, the Alarm List will 
hide duplicate alarms, and display "More..." next to an alarm if 
duplicates exist.  

 

Note: Only ARC Plus, ARC Solo and SNMP alarms can be cleared individually (using "Clear Selected 

Alarms"). ARC-16 and GSC3000/VRC2500 sites only support clearing all alarms at once. 

To clear alarms on a single site only, use the Site Alarms dialog. 

Fields 

Date/Time The date and time (in the local time zone) when the alarm occurred.  

Duration For inactive alarms, the duration (hours, minutes, and seconds) for which the alarm 
was active.  

Network The name of the Network in AutoPilot where this alarm occurred.  

Site The name of the Site where this alarm occurred.  

Severity The severity (warning or critical) of the alarm.  

Priority The priority of the alarm (1 – 255).  

Alarm Type Describes the source of the alarm (meter, status, system, user, etc).  

Message Describes the alarm condition.  

Time Cleared For cleared alarms, the date and time (in the local time zone) when the alarm was 
cleared.  

 

Note: To sort alarms by one of the fields above, click on the field in the list's header. Click again to 

sort in the opposite direction. 
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Icons 

The following icons are displayed in the Alarm List to describe the type and state of an alarm: 

 Active Alarm This alarm is active, not cleared, and occurred before AutoPilot 
connected to the site.  

 New Active Alarm This alarm is active, not cleared, and happed after AutoPilot connected 
to the site.  

 Inactive Alarm This alarm is no longer active.  

 Incidental Alarm This is an incidental alarm that occurred before AutoPilot connected to 
the site. 

 New Incidental Alarm This is an incidental alarm that occurred after AutoPilot connected to 
the site.  

 Cleared Alarm  

Root and Subordinate Alarms 

When Alarm Relationships are defined, the Alarm List will display an expansion icon next to a root 

alarm, and "roll up" subordinate alarms. 

 

Root Alarm, shown expanded with subordinate alarms below it 

 Adding Alarms 

The ARC Plus supports user-generated alarms. To add an alarm to the ARC Plus, right-click the icon for 

the desired site in the Resources window or Navigator and select "Add Alarm Message...". Select an 

alarm severity and priority, and enter a message for the alarm. Click OK to create the alarm. 

 

Add Alarm Message Dialog 

 

Note: Critical alarms will cause the ARC Plus to dial out, if an ESI or RSI is installed. 
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Alarm Notifications 

In addition to the Alarm List, AutoPilot can notify you of alarm conditions using the New Alarm dialog, 

the New Alarm Desktop Alert, and sounds. For more information on configuring alarm notifications, 

see Alarm Notifications (PAGE 54). 

 

New Alarm Dialog 

 

 

New Alarm Desktop Alert 

Device-Specific Features 

 
ARC Plus          

 
ARC Solo ARC-16 

GSC3000 
VRC2500 SNMP 

Alarm Severity ✓ ✓  ✓  

Alarm Priority ✓     

Inactive Alarms ✓ ✓ ✓  ✓ 

Clear Individual 
Alarms 

✓ ✓   ✓ 

Add New Alarms ✓     

 

 ARC-16 Notes: 

The state of ARC-16 alarms is determined when AutoPilot connects to an ARC-16 site. Alarms can only 

be considered "inactive" when the alarm state changes while AutoPilot is connected. 

Clearing alarms in AutoPilot will clear the ARC-16 alarm indicator, and instruct the ARC-16 to stop 

dialing its phone list to report current alarms. 
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SNMP Notes: 

SNMP alarms are created when AutoPilot receives an SNMP trap from a Network Device. The message 

for an SNMP alarm is determined by the OID (Object Identifier) reported by the trap. 

If the OID of the trap is found in the MIB for the Network Device, the description of that OID is used for 

the alarm message. If AutoPilot cannot find an entry in the MIB for the OID, it will use the OID value 

itself. 

Events 

The ARC Plus includes an onboard Event List. The Event List displays site activity such as commands, 

macro activity, connections, etc. The kinds of events stored in the log can be configured using 

AutoLoad Plus. 

 Event List 

The Event List in AutoPilot is, by default, displayed docked to the bottom of the screen in a tabbed 

group with the Alarm List. 

 

Event List 

 

Fields 

Date/Time The date and time (in the local time zone) when the event occurred.  

Network The name of the Network in AutoPilot where this event occurred.  

Site The name of the Site where this event occurred.  

Event Type Describes the source of the event (macro, command, error, etc).  

Message Describes the event.  
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Adding Events 

The ARC Plus and ARC Solo support user-generated events. To add an event to the ARC Plus or ARC 

Solo, right-click on the icon for the desired site in the Resources window or Navigator and select "Add 

Event Message...". Enter a message for the event and click OK. 

 

Add Event Message Dialog 

Macros 

The ARC Plus and GSC3000/VRC2500 include onboard Macros. In AutoPilot, Macros can be run or stop 

using the Macro List, or buttons in Custom Views. 

Note: To add, edit, or remove macros from a site, use AutoLoad Plus or the Jet Designer in AutoPilot 

for ARC Plus, use the Jet Designer for ARC Solo, and use AutoLoad GSC for GSC3000/VRC2500. 

 Macro List 

The Macro List, by default, is docked to the right side of the screen and set to auto hide. 

The Macro List shows all of the macros on the selected site, and allows you to run or stop macros, and 

displays the current state of each macro using the icons below. The Macro List includes Jet Flowcharts 

that have been created to run directly on ARC Plus or Arc Solo. 

Note: If a Custom View or Report is selected instead of a site, the Macro List will display nothing. 

Tool Bar Icons 

 Run Runs the selected macro.  

 Stop Stops the selected macro.  

 

Macro State Icons 

 Running The macro is currently running.  

 Error The macro has stopped running due to an error. 
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Network Devices Overview 

A Network Device is any device on your LAN, WAN, or Internet that can be pinged or queried via SNMP 

(Simple Network Management Protocol). AutoPilot will periodically query Network Devices, and can 

use parameters from these devices in logs, reports, and Custom Views. 

For more information on configuring Network Devices, see Adding Network Devices (PAGE 31). 

Default View 

When a Network Devices is selected in the Resources window or Navigator, AutoPilot shows a grid-

style Default View with the response time and other parameters for the selected device. 
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Adding Sites 

 Adding ARC Plus or Arcturus Networks 

Note: One or more ARC Plus or Arcturus sites configured for site-to-site communication are an ARC 

Plus Network. 

AutoPilot can connect to some or all of the sites in an ARC Plus Network.  

To add a new ARC Plus network, click File -> New -> ARC Plus Network... to bring up the ARC Plus 

Network Wizard. 

Once the wizard is complete, your ARC Plus Network (and its sites) will appear in the Resources 

window. 

 

To change your settings, or add/remove sites from the network, you can return to the wizard later by 

right-clicking a network in the Resources window and choosing "Edit ARC Plus Network...". 

ARC Plus Network Wizard 

 

Welcome 
Click "Next" to start the Wizard. 

 

Network Name and Login 
Enter a name to describe this ARC Plus Network. The 
name will be displayed through AutoPilot. 
 
Enter your user name and password for this Network. 
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Connect to your Network 
Select either TCP/IP or Modem as your connection 
method. For TCP connections, enter the IP address and 
Port of any ARC Plus site on this network. For modem 
connections, select your modem and enter the phone 
number of your ARC Plus. 
 
Note: When using a modem connection with an ESI 
(Enhanced Speech Interface) or RSI(Recordable Speech 
Interface), enter a dialing pause to allow enough time for 
your greeting before the modem switches to data mode. 
 

 

Connecting 
Click Next to continue after the ARC Plus Wizard 
connects to your site. 

 

Site List 
Using the site tree, click the checkbox next to each site in 
this network that you want AutoPilot to use. Click the 
checkbox next to the "Sites" folder to select all sites. 

 

Connections 
By default, each site you have selected is configured to a 
TCP/IP connection using its assigned IP address. 
 
For any site, you can adjust the following connection 
settings: 

Connect automatically  
When checked, AutoPilot will automatically connect to 
this site on startup.  

Connection method and settings  
Each site's primary connection can be configured to use 
TCP/IP or a Modem  
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Low speed connection  
When checked, AutoPilot will adjust its timeout settings 
to allow for a low speed connection (such as Satellite).  

Backup Connection  
When enabled, AutoPilot will switch to the backup 
connection settings if the primary connection is 
unavailable.  

Retry primary  
When a backup connection is enabled, AutoPilot can 
retry the primary connection periodically.   
 

 

Logging 
If desired, AutoPilot can automatically log all or some of 
the sites on this network. 
 
Logging can be configured individually for each site, or all 
sites in this network can use the same settings. Using 
either method you can configure the following: 

Enable logging on this site 
Checking this box enables logging for the selected site(s).  
 
Configure all sites or individual sites 
Select Configure each site individually if you want to 
customize settings for each site, or select Use the same 
settings for all sites in the network to apply the settings to 
all sites. 
 
Interval  
This is the frequency, in minutes or hours, at which 
AutoPilot will take its log.  

Next log  
This is the time of day when AutoPilot will take its first 
log. AutoPilot will always add the logging interval to the 
next log time to determine when it is time to log again. 
By doing so, AutoPilot can keep to a regular "pattern" for 
its log (such as every hour on the hour).   
 
Download Captures from this site 
Select the Download Captures from this site option to 
enable the Captures feature, available on ARC Plus Touch 
units with firmware 5.0.8.1 or newer, allows you to 
configure the ARC Plus Touch to store periodic captures 
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(snapshots) of a specified range of channel values locally 
on The ARC Plus Touch. You can create a download 
schedule on any AutoPilot system to automatically 
retrieve the captures.  
 
Interval 
The download Interval (the frequency, in minutes or 
hours), at which AutoPilot will download its next captures 
from the ARC Plus.  
 

 

Finish 
Click Finish to save your ARC Plus Network and close the 
wizard. 
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 Adding ARC Solo Networks 

To add a new ARC Solo network, click File -> New -> ARC Solo Network... to bring up the ARC Solo 

Network Wizard. 

Once the wizard is complete, your ARC Solo Network (and its sites) will appear in the Resources 

window. 

To change your settings, or add/remove sites from the network, you can return to the wizard later by 

right-clicking a network in the Resources window and choosing "Edit ARC Solo Network...". 

ARC Solo Network Wizard 

 

Welcome 
Click "Next" to start the Wizard. 

 

Network Name and Login 
Enter a name to describe this ARC Solo Network. The name will 
be displayed through AutoPilot. 
 
Enter your user name and password for this Network. 
Enable Always prompt for password when connecting if you 
want to disable an automatic connection to log. 

 

Connection 
Enter the hostname or IP address of the host.  
Select the host port. 
 
Select settings for SSL and automatic connection. 

Connect automatically  
When checked, AutoPilot will automatically connect to this site 
on startup.  
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Logging 
If desired, AutoPilot can automatically log all or some of the sites 
on this network. 
 
Logging can be configured individually for each site, or all sites in 
this network can use the same settings. Using either method you 
can configure the following: 

Enable logging  
Checking this box enables logging for the selected site(s).  

Log every  
This is the frequency, in minutes or hours, at which AutoPilot will 
take its log.  

Next log  
This is the time of day when AutoPilot will take its first log. 
AutoPilot will always add the logging interval to the next log 
time to determine when it is time to log again. By doing so, 
AutoPilot can keep to a regular "pattern" for its log (such as 
every hour on the hour).   

 
Finish 
Click Finish to save your ARC Solo Network and close the wizard. 
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 Adding ARC-16 Networks 

To add a new ARC-16 Network, click File -> New -> ARC-16 Network... to bring up the ARC-16 Network 

Wizard. 

Note: ARC 16 sites can only be accessed in the Resources window; you cannot drag them into the 

Navigator. 

Once the wizard is complete, your ARC-16 Network (and its sites) will appear in the Resources window.  

To change your settings, or add/remove sites from the network, you can return to the wizard later by 

right-clicking a network in the Resources window  and choosing "Edit ARC-16 Network". 

Important notes for modem connections: 
The ARC-16's modem uses Bell 212A modulation. Many computer modems require special 
initialization strings to work with Bell 212A, and some do not support this method at all. Refer to your 
modem's documentation for more information. 
 
If you do need to enter an initialization string, you can do so in the "Phone and Modems" section of 
the Windows Control Panel. 

 

Important notes for direct connections: 
The normal connection between a PC running AutoPilot and an ARC-16 is a full null modem cable, 
where AutoPilot 2 and 3 permitted a 3-wire cable. 

Customers with older ARC-16s (Rev. A CPU boards) upgrading from AutoPilot 2 or 3 need to verify that 
a full null modem cable is being used. 

For customers using ARC-16s with Rev. B boards, either use a full null modem cable or download a new 
SerialPorts.xml file to your AutoPilot directory. This will allow AutoPilot to communicate using only 
TX, RX & GND. A copy of the file can be downloaded from: 

http://www.burk.com/assets/burk/products/SerialPorts.xml 

After you download the file: 

1. Open the XML file with a text editor (Windows Notepad, for example).  The file contains the  

name of the serial port on the PC that communicates with the ARC-16 ( COM4 or COM1, for 

example). Edit the file to match the COM port you plan to use.  

2. Save the file in C:\Program Files (x86)\Burk Technology\AutoPilot. 

  

http://www.burk.com/assets/burk/products/SerialPorts.xml
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ARC-16 Network Wizard 

 

Welcome 
Click "Next" to start the Wizard. 

 

Network Name and Password 
Enter a name to describe this ARC-16 Network. The name will 
be displayed through AutoPilot. 
 
Enter your password for this network, and the Authorization 
Code for the ARC-16 that you are connecting to directly. 
 
If you do not have an Authorization Code, contact Burk 
Technology at 978-486-0086, or on the web at 
www.burk.com. 

 

Primary Connection 
Select the method that you want to use to connect to this 
network. The following options are available: 

Web Interface  
Connect using an ARC-16 Web Interface. Enter the IP address 
(or host name) and TCP port for your Web Interface.  

TCP/IP (other)  
Connect using a 3rd party serial-to-Ethernet converter. Enter 
the IP address (or host name) and TCP port for your converter.  

Direct  
Connect using a COM port on this computer. Select the desired 
COM port from the list.  

Modem  
Connect using a modem. Select the desired modem from the 
list and enter the phone number for the ARC-16.   
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Backup Connection 
(See above for descriptions of the different connection 
options). 
 
When enabled, AutoPilot will switch to the backup connection 
settings if the primary connection is unavailable. 
 
When a backup connection is enabled, AutoPilot can retry the 
primary connection periodically. 

 

Connecting 
Click Next to continue after the ARC-16 Wizard connects to 
your site(s). 

 

Logging 
If desired, AutoPilot can automatically log all or some of the 
sites on this network. 
 
Logging can be configured for each site in this network. Using 
the tab for the desired site, configure the following: 

Enable logging  
Checking this box enables logging for the selected site.  

Interval  
This is the frequency, in minutes or hours, at which AutoPilot 
will take its log.  

Next log  
This is the time of day when AutoPilot will take its first log. 
AutoPilot will always add the logging interval to the next log 
time to determine when it is time to log again. By doing so, 
AutoPilot can keep to a regular "pattern" for its log (such as 
every hour on the hour).  

Time zone  
Select the time zone where this site is located.   
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Channel Setup 
Configure meter, status, and command channels for each site in 
this network. 

Meters 
Select "Meters" for the desired site from the site tree. The 
meter name and units label are set in the channel grid. 

Name  
Enter a name to describe this channel.  

Units  
Enter a units label for this channel.  
Select a channel in the grid to load additional settings in the 
properties list on the right. 
 

Min  
The minimum value displayed on a graphical meter for this 
channel.  

2nd Low [color]  
The color displayed for the second lower limit of a graphical 
meter.  

2nd Low [value]  
The value where the second lower limit of the meter begins.  

1st Low [color]  
The color displayed for the first lower limit of a graphical meter.  

1st Low [value]  
The value where the second first limit of the meter begins.  
Normal  
The color displayed for the "normal" range of a graphical meter.  

1st High [color]  
The color displayed for the first upper limit of a graphical meter.  

1st High [value]  
The value where the second first upper of the meter begins.  

2nd High [color]  
The color displayed for the second upper limit of a graphical 
meter.  

2nd High [value]  
The value where the second upper of the meter begins.  
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Max  
The maximum value displayed on a graphical meter for this 
channel.  

Status 
Select "Status" for the desired site from the site tree. 

On Label  
The label that will be displayed when the status is "on".  

Off Label  
The label that will be displayed when the status is "off".  

On Color  
The color that will be displayed for a status indicator when the 
status is "on".  

Off Color  
The color that will be displayed for a status indicator when the 
status is "off".  

Commands 
Select "Commands" for the desired site from the site tree. 

Raise Label  
AutoPilot will use this label on raise buttons for this site.  
Duration [raise]  
The duration (in seconds) for which the raise command will be 
active.  

Lower Label  
AutoPilot will use this label on lower buttons for this site.  
Duration [lower]  
The duration (in seconds) for which the lower command will be 
active.   

 

Finish 
Click Finish to save your ARC-16 Network and close the wizard. 
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 Adding GSC3000/VRC2500 Sites 

Note: A VRC2500 appears in AutoPilot as a single I/O 16. 

Voice Interface units are not used in AutoPilot, and will not appear as a part of your site. 

A GSC3000 site may include up to 16 units of the following types: 

• I/O 16  

• I/O 8  

• GT-4  

• GX-128  

• AC-4  

• AC-8  

• OneConnect  

To add a new GSC3000/VRC2500 Site, click File  New  GSC/VRC Site... to bring up the GSC/VRC Site 

Wizard. 

Once the wizard is complete, your site will appear in the Resources window. 

Note: GSC3000 and VRC2500 sites can only be accessed in the Resources window; you cannot drag 

them into the Navigator. 

To change your settings you can return to the wizard later by right-clicking a site in the Resources 

window and choosing "Edit GSC/VRC Site". 

Important notes for direct connections: 
The normal connection between a PC running AutoPilot and an GSC/VRC is a full null modem cable, 
where AutoPilot 2 and 3 permitted a 3-wire cable. Either use a full null modem cable or download a 
new SerialPorts 2.xml file to your AutoPilot directory. This will allow AutoPilot to communicate using 
only TX, RX & GND. A copy of the file can be downloaded from: 

http://www.burk.com/assets/burk/products/SerialPorts_2.xml 

After you download the file: 

1. Open the file with a text editor (Windows Notepad, for example). The file contains the name of 
the serial port on the PC that will communicate with the GSC/VRC ( COM4  or COM1, for 
example). Edit the file to match the COM port you plan to use.  

2. Save the file in C:\Program Files (x86)\Burk Technology\AutoPilot. 
  

http://www.burk.com/assets/burk/products/SerialPorts_2.xml
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GSC/VRC Wizard 

 

Welcome 
Click "Next" to start the Wizard. 

 

Site Information 
Enter a name to describe this site. The name will be displayed 
through AutoPilot. 
 
Enter your password and Authorization Code for this site. 
 
If you do not have an Authorization Code, contact Burk 
Technology at 978-486-0086, or on the web at www.burk.com. 

 

Primary Connection 
Select the method that you want to use to connect to this site. 
The following options are available: 

Direct  
Connect using a COM port on this computer. Select the desired 
COM port from the list.  

Dialup  
Connect using a modem. Select the desired modem from the 
list and enter the phone number for the site.  
 
If your modem is connected to a Voice Interface, end the phone 
number with several commas followed by 020. The commas 
instruct the modem to pause, allowing for the Voice greeting. You 
may need to experiment to determine the correct number of 
commas to use for your greeting. 

Connect using TCP/IP (including GSC/VRC Web Interface)  
Enter the IP address (or host name) and TCP port number for 
your site.  

Timeouts 
By default, AutoPilot will automatically determine appropriate 
timeout values for use with your site, and adjust those values as 
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site conditions change. If you would rather specify these 
settings manually, you may do so here. 

 

Backup Connection 
(See above for descriptions of the different connection 
options). 
 
When enabled, AutoPilot will switch to the backup connection 
settings if the primary connection is unavailable. 
 
When a backup connection is enabled, AutoPilot can retry the 
primary connection periodically. 

 

Logging 
If desired, AutoPilot can automatically log this site. The 
following logging parameters can be configured: 

Enable logging  
Checking this box enables logging for this site.  

Interval  
This is the frequency, in minutes or hours, at which AutoPilot 
will take its log.  

Next log  
This is the time of day when AutoPilot will take its first log. 
AutoPilot will always add the logging interval to the next log 
time to determine when it is time to log again. By doing so, 
AutoPilot can keep to a regular "pattern" for its log (such as 
every hour on the hour).  

Time zone  
Select the time zone where this site is located.  

Logging method  
AutoPilot can log either by taking readings directly, or by using 
the GSC3000/VRC2500's onboard captures.   

 

Finish 
Click Finish to save your site and close the wizard. 
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 Adding Network Devices  

To add a new Network Device, click File -> New -> Network Device... to bring up the Network Device 

Wizard. 

Once the wizard is complete, your device will appear in the Resources window and you can drag it into 

Navigator. 

To change your settings you can return to the wizard later by right-clicking a device in the Resources 

window or Navigator and choosing "Edit Network Device". 

Network Device Wizard 

 

Welcome 
Click "Next" to start the Wizard. 

 

Device Settings 
Enter a name to describe this device. The name will be 
displayed through AutoPilot. 
 
Enter the IP address for this device. 
 
If desired, adjust the timeout (the number of seconds AutoPilot 
will wait for a response to a ping or SNMP GET request). 

 

Ping and SNMP 
You can enable ping and/or SNMP management for this device. 
 
When using ping, enter the rate (in minutes) at which you want 
to ping this device. 
 
For SNMP management, the following parameters are 
available: 

SNMP port  
The port used by this device's SNMP agent (161 by default)  

Community string  
The read only community string for the SNMP agent.  

SNMP version  
The version of SNMP used by the SNMP agent (1, 2c, or 3).  
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User name  
(For SNMP v3 only) your user name on the SNMP agent.  

Password  
(For SNMP v3 only) your password on the SNMP agent.   

 

MIB Files 
By default, AutoPilot includes the standard MIB files. You can 
add additional MIB files for device or vendor specific 
parameters by clicking the "Add" button. 
 
AutoPilot uses the MIB to facilitate selecting parameters (see 
below), and for reading SNMP traps. 

 

MIB Browser 
Use the MIB browser to select the parameters you want 
AutoPilot to use. When you select a parameter in the tree, 
AutoPilot will display its name, OID (Object Identifier) and 
description. Click "Get" to read this value. 

 

Other OIDs 
To add OIDs that are not available in your device's MIB, enter 
the OID value and assign it a name. 
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SNMP Channel Assignment 
For each parameter you have chosen, you can assign the 
following: 

Channel type  

Parameters can be interpreted as meters, status, or text 
channels.  

Polling rate  

This is the rate at which AutoPilot will request the value for this 
parameter.  
 
Each type of channel has different configuration options. You 
can configure how the channel behaves and how it is displayed 
in AutoPilot. 

Meter 

Settings 

Label  

Assign a label to describe this meter.  

Units  

The units label for this meter.  

Decimal places  

The number of decimal places to show for this meter's value.  

Meter min  

The minimum value shown on a graphical meter for this 
channel.  

Meter max  

The maximum value show on a graphical meter for this channel.  

Multiplier  

AutoPilot will multiply the value received from the SNMP agent 
by the multiplier.  

Limits 

2nd Low [color]  

The color displayed for the second lower limit of a graphical 
meter.  

2nd Low [value]  

The value where the second lower limit of the meter begins.  

1st Low [color]  

The color displayed for the first lower limit of a graphical meter.  
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1st Low [value]  

The value where the second first limit of the meter begins.  

Normal  

The color displayed for the "normal" range of a graphical meter.  

1st High [color]  

The color displayed for the first upper limit of a graphical meter.  

1st High [value]  

The value where the second first upper of the meter begins.  

2nd High [color]  

The color displayed for the second upper limit of a graphical 
meter.  

2nd High [value]  

The value where the second upper of the meter begins.  

Status 

On Label  

The label that will be displayed when the status is "on".  

Off Label  

The label that will be displayed when the status is "off".  

On Color  

The color that will be displayed for a status indicator when the 
status is "on".  

Off Color  

The color that will be displayed for a status indicator when the 
status is "off".  

On string  

AutoPilot will consider this status channel to be "on" when the 
value received from the SNMP agent matches the "on string".  

Text 

Label  

The label describing this channel.  
 
If this channel is used to measure a duration (such as "uptime"), 
check the corresponding checkbox. AutoPilot will read the 
value of this parameter as a duration and display it 
appropriately. 
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Logging 
If desired, AutoPilot can automatically log this device. The 
following logging parameters can be configured: 

Enable logging  
Checking this box enables logging for the device.  

Interval  
This is the frequency, in minutes or hours, at which AutoPilot 
will take its log.  

Next log  
This is the time of day when AutoPilot will take its first log. 
AutoPilot will always add the logging interval to the next log 
time to determine when it is time to log again. By doing so, 
AutoPilot can keep to a regular "pattern" for its log (such as 
every hour on the hour).  

Time zone  
Select the time zone where this device is located.  
Note: AutoPilot only logs meter and status channel on Network 
Devices. "Text" channels are not included in the log. 
 

 

Finish 
Click Finish to save your device and close the wizard. 

Alarms on Network Devices 

AutoPilot will automatically treat incoming SNMP traps as alarms for the Network Devices you have 

added. Be sure to include the appropriate MIB files to be sure AutoPilot is able to correctly identify 

alarms. 

Note: To configure your SNMP agent to send traps to AutoPilot, refer to the documentation for the 

device, or contact your network administrator. 

AutoPilot uses UDP port 162 to receive SNMP traps.  

Only one program on your computer can operate as an SNMP manager using the standard port 

numbers. If you have another SNMP manager running already, you must first disable it before you can 

use SNMP management in AutoPilot. 
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Only one program on your computer can operate as an SNMP manager 
using the standard port numbers. If you have another SNMP manager 
running already, you must first disable it before you can use SNMP 
management in AutoPilot. 

 

Creating Custom Views 

Custom Views allow you to tailor AutoPilot's interface to suit your operation's needs. You can create 

Custom Views using built-in templates, or from scratch with the Custom View Editor. 

Terminology 

Custom View Control  A Custom View Control is an onscreen element such as a graphical meter, 
status LED, or command button.  

Binding  Binding a Custom View Control to a remote control channel or other 
parameter creates a link between that parameter's value or associated 
action and the behavior of the control. Binding to a meter channel causes 
the control to display the meter's value. Binding to a status condition 
causes the control to display the status condition (on or off). Binding to a 
command causes the control to execute that command when clicked.  

Control Properties  A control's properties are attributes that define its appearance and 
behavior, such as colors, limits, and labels.  

Custom View 
Template  

A Custom View Template is a pre-defined Custom View that you can 
associate with your site. You can edit the resulting Custom View to tailor it 
to your specific needs.  

Selection Handles  Selection handles are squares that appear around a selected control. 
Selection handles are used to indicate which control or controls are 
selected, and to resize the control. 

Custom View Editor Overview 

The Custom View Editor allows you to create and edit Custom Views. The components of the editor are 

described below. 
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Canvas 

The canvas is where you will arrange your Custom View controls. When you display your Custom View 

in AutoPilot, only the canvas is shown. 

 

Canvas 

 

Grid 

By default, the Custom View Editor displays grid dots on the canvas. The grid is useful for aligning and 

positioning controls. 

You can turn the grid on an off by clicking "Show Grid" from the View menu in the Custom View Editor. 

Primary Control Selection 

When more than one control is selected, one control is the primary control. Some actions in the Custom 

View Editor only apply to the primary selection, or otherwise relate to it. 

The primary control is indicated by normal selection handles (black, by default). Secondary selection 

handles are shown using a reverse color scheme. 

 

Multiple controls selected. The primary control is shown with black selection handles. 

Note: When displayed in AutoPilot, your Custom View will not show the grid. 
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 Toolbox 

The toolbox is a categorized list of all the Custom View controls available to you. Each control appears 

in its associated category (Meters, Status, etc), as well as in the "All Items" category. To add a control to 

the canvas, click and drag the control to the desired location. When you release the mouse button, the 

Custom View Editor will add a new instance of the selected control to the canvas. 

 

Toolbox 

 Properties 

The properties grid displays and allows you to edit all of the properties for the selected control. 

To change a property, select its value in the grid and replace it with the desired value. Some properties 

use pull down menu or popup dialog (indicated by a "..." button). 

A description of each property appears at the bottom of the property grid when a property row is 

selected. 

Note: If more than one control is selected, the properties grid uses the primary control (see above). 

 

Properties 
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 Undo History 

The undo history list displays recently performed actions that you can undo (or redo). Double-clicking 

on an item in the list will undo or redo that action. 

 

Undo History 

Adding, Positioning and Sizing Controls 

To add a control to the Custom View canvas, click and drag the control from the toolbox and drop it 

onto the canvas. 

To move a control already on the canvas, simply click and drag to reposition it. 

To resize a control, select the control by clicking on it and use the grab handles to resize it. Control scan 

be resized horizontally or vertically, or diagonally using the corner handles. 

Snap to Grid 

To make it easier to align and position controls, the Custom View Editor can force controls to conform 

to the grid as they are moved and sized. This functionality is enabled by default, and can be toggled by 

selecting "Snap to Grid" from the Format menu. 

Positioning Controls on Top or Below Other Controls 

Use "Send to Back" and "Bring to Front" from the Format menu to position controls above or below 

other controls on the canvas. 

Sizing and Aligning Controls Relative to Other Controls 

The Custom View Editor has several tools that allow you to size and align controls relative to other 

controls on the canvas. These are useful tools to help create Custom Views with a polished, professional 

appearance. 

To use these tools, select multiple components at once by using Ctrl+Click or clicking and dragging a 

selection rectangle around the desired controls. 
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 Align Lefts Aligns all the controls on the left hand side.  

 Align Centers  Aligns all the controls in the center.  

 Align Rights  Aligns all the controls on the right hand side.  

 Align Tops  Aligns all the controls on the top.  

 Align Middles  Aligns all the controls in the middle.  

 Align Bottoms  Aligns all the controls on the bottom.  

 Make Same Width  Sets all the controls to the same width.  

 Make Same Height  Sets all the controls to the same height.  

 Make Same Size  Sets all the controls to the same size.  

 Make Horizontal Space Equal  Spaces all the controls so that horizontal spacing is equal 
between each control.  

 Increase Horizontal Space  Increases the horizontal spacing between each control.  

 Decrease Horizontal Space  Decreases the horizontal spacing between each control.  

 Remove Horizontal Space  Removes all horizontal spacing between the controls.  

 Make Vertical Space Equal  Spaces all the controls so that vertical spacing is equal between 
each control.  

 Increase Vertical Space  Increases the vertical spacing between each control.  

 Decrease Vertical Space  Decreases the vertical spacing between each control.  

 Remove Vertical Space  Removes all vertical spacing between the controls.  

 Center Horizontally in View  Positions the controls in the center of the view horizontally.  

 Center Vertically in View  Positions the controls in the center of the view vertically. 

Binding to Channels 

Binding a control to a channel connects its value or action to the selected channel. Controls can be 

bound to the following: 

• Commands (relays on a remote control or actions performed in AutoPilot).  

• Meters  

• Status (remote control status channels or other site conditions).  

• SNMP strings  

• Network Device state  
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To bind a control, right click on the control and select the type of channel to which you want to bind. 

 

Context menu used to bind channels. Normally, unavailable channel types are grayed out. 

Binding Dialogs 

To finish binding a channel, use the binding dialog to select the channel (or other data) to which you 

want to bind. 

Check "Automatically set related properties" if you want the properties for this control to match the 

settings for the target channel as configured in AutoLoad Plus. For example, if you are binding a 

graphical meter to a meter channel, checking this box will set the min and max values and colors to 

match the configuration of the meter channel. 

 

An example of a binding dialog. The dialog varies based on the type of channel and other selections. 
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Customizing Control Properties 

Every Custom View control has its own set of properties that you 

can use to customize its appearance and behavior. These 

properties are displayed in the properties window, docked, by 

default, to the right side of the screen. 

To adjust a property, simply select it in the grid and enter the 

desired value. 

Some properties use a drop-down display or popup dialog to 

support more advanced editing. Some properties have 

expand/collapse buttons to show more/less to expose/hide 

additional settings related to a property (such as "Size" and 

"Location"). 

A brief description of each property is available at the bottom of 

the property grid. 

Note: For objects that have a customizable image property, the 

image size must be smaller than 3MB.  

Map to Key Property 

The Click Action group for each Custom View control includes a 

property called “Map to Key”. This property makes it possible to 

activate the control’s click action by pressing the configured 

keyboard key.  

Adjusting the Property Grid Display 

• The pane at the bottom of the property grid used for the description can be resized to show 

more or less of the text.  

• The columns of the property grid can be resized by clicking on the vertical dividing line between 

them.  

• The properties listed in the grid can be sorted alphabetically, or organized by group. Use the 

buttons in the property grid tool bar to change the order. 

Using Charts 

The Custom View Chart control allows you to plot one or more meter channels on a strip chart. Because 

the chart control can support multiple lines, using it is different from other metering controls. 

Creating a New Chart 

Begin by dragging and dropping a chart onto the Custom View canvas, as you would any other control. 

To add a meter channel to the chart, use the "Chart Lines" property, found in the "Data" category in the 

property grid. Click the [...] button to open the editor dialog. 
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Select the network, site, and channel for the line you want to add. Click "Save" to add the line to the 

chart. You may add as many lines as you like, and can specify the color and style (solid, dotted, etc) for 

each line. 

 

The Chart Lines dialog 

The following fields are available for each chart line: 

Channel Type The type of channel to be plotted. 

Network The network containing this meter channel.  

Site  The site containing this meter channel.  

Channel  The meter channel you want to plot.  

Label The label to use for line name. 

Color  The color the chart will use to draw this line.  

Line Style  The style of the line (solid, dotted, etc).  

Area Style The area fill style to use (solid or none). 

Y Axis  The axis (left or right) that this line will use as its Y-axis.  

Using the Secondary Y-Axis 

If you want to use a single chart to plot channels that use two different units – such as forward power as 

a percentage and reflected power in Watts – you can use both the left and right Y-axes. To do so, simply 

pick "Left" or "Right" as desired for each line in the Chart Lines dialog. 

Adjusting the Y-Axis Range 

By default, AutoPilot will automatically scale the y-axis range to suit the data plotted on the chart. This 

range will continue to change over time as new values arrive. If you would prefer to configure a static 

range, you may do so using the "Left Y Axis" and "Right Y Axis" properties for the chart. 

First, set the "Auto Scale" property of the axis to "False". Then set the "Minimum Value" and "Maximum 

Value" properties to suit your needs. 

Adjusting the Time Span 

The duration of the chart is configured using the "Duration (sec)" property of the chart. This specifies 

the time span represented by the x-axis. Although this property uses seconds, the chart supports 

months or even years of data. 
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Pre-Loading Data and Background Caching 

When AutoPilot first loads a chart, it will use your logged data to pre-load values into the chart. The 

amount of data available for this feature depends on your logging settings and the range of the chart. 

When AutoPilot starts, it will immediately begin "caching" data for your charts, even if they are not on 

screen. 

Editing and Deleting Custom Views 

Editing Existing Custom Views 

To edit an existing Custom View, right-click on the Custom View in the AutoPilot Resources window  or 

Navigator and select "Edit Custom View...". AutoPilot will open the Custom View in the Custom View 

Editor. 

You can also use the File -> Open dialog in the Custom View Editor to open a Custom View file directly. 

Deleting Custom Views 

To delete a Custom View, right-click on the Custom View in the AutoPilot Resources window and select 

"Delete". If you delete a Custom View from the Navigator, only that instance of the view is deleted. To 

completely remove the Custom View, it must be deleted in the Resources window. 

Note: If you delete a Custom View file directly in Windows, AutoPilot will automatically remove that 

Custom View from the Resources window and Navigator. 

Using Custom View Templates 

Custom View Templates allow you to quickly configure a pre-defined Custom View to work with one of 

your sites. A template that resembles the Default View is available, as well as templates for 

PlusConnect™ transmitter interfaces. 

To create a new Custom View from a template, open the Custom View Editor (File  New Custom 

View) and select "New From Template" from the File menu in the editor. 

The "Load Template" dialog will prompt you for the following information: 

Template  Click the browse button ("...") to locate the template you want to use.  

Network  Choose the network containing the site that you want to use for this Custom 
View.  

Site  Choose the site that you want to use in this Custom View.  

Starting channel  Templates are designed to work with a sequential set of channels. For example, 
to use channels 17-32 on the selected site, enter "17" as the starting channel.  

 

Note: When using Custom View Templates for PlusConnect channels, use the same "starting 

channel" value that you used in AutoLoad Plus when you set up the PlusConnect. 



 

45 
 

 

The Load Template dialog prompts you for the template and site information necessary to configure your new Custom 
View. 

Creating Reports 

AutoPilot reports allow you to view and archive site data in a readable, professional format. Reports can 

contain data from any number of sites, even when each site uses a different type of remote control. 

When you create a report in AutoPilot, you are creating a "template" to describe what data a report 

should include, and how it should be presented. When you run a report, AutoPilot reads the data 

directly from the onboard database. Once you create a report, you can run it any time you need to in 

the future without having to make any edits to update data. 

Note: For best performance, AutoPilot reports always read data from the computer's local database, 

even when SQL Server logging is enabled. 

 Using the Report Wizard 

To create a new report using the Report Wizard, select File  New  Report... in AutoPilot. 

 

Welcome 
Click "Next" to start the Wizard. 
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General 
Select the desired page orientation. Reports can use portrait or 
landscape orientation. 
 
Select the desired sort order for your site data. Data can be 
sorted in ascending or descending order. 
 
Check the "Page break for each day" checkbox if you want each 
day's data to begin on a new page. 

 

Date Range 
This page allows you to select the dates that will be included in 
the report. Because AutoPilot reads from the database each 
time you run a report, it will always use the most current data. 
 
There are several ways AutoPilot can filter data by date: 

Include all dates  
AutoPilot will use all of your logged data. This is not 
recommended if you have been logging for a long time.  

Show data between...  
This option allows you to select specific start and end dates 
(inclusive) to include in the report. Because AutoPilot will use 
these exact dates, this is useful for "one-off" reports, and not 
reports that you intend to reuse.  

Show data from the last...  
This option will use range of dates that ends today (the day the 
report is run, not the day it is created) and begins a certain 
amount of time before today. For example, if you enter "10 
Days", the report will include data starting 10 days ago and 
ending today.  

Show data from the prior...  
This option uses an even block of time, ending no later than the 
day the report is run. For example, if you enter "1 Week" the 
report will include data from last week. This option is useful for 
reports that you intend to run on a regular basis, where you 
want the date range to fall on even boundaries.  

Show this ... to date  
This option shows the current block of time (month, week, etc) 
up through the current date (the date the report is being run). 
For example, if you select "Month" and run the report on April 
20, the report will show April 1 through April 20.   
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Select Sites 
Place a checkmark in the list next to each site that you want to 
include in the report. You must include at least one site. 

 

Meter Channels 
This page allows you to select the meter channels that you 
want to include in the report. Meter channel values are 
displayed in columns on the report. For best results, limit the 
number of meter channels you include in your report to what 
will fit cleanly on the page. If there is not enough room for all of 
your channels, the report will span multiple pages with different 
sets of channels on each page. 
 
To add channels, select the site from the "Site" drop-down and 
then select the desired channel(s) in the "Channels" list. Click 
"Add" to add the selected channel(s), or click "Add All" to add all 
channels. 
 
The channels you have selected appear in the "Selected 
Channels" list. You can select channels in this list and click 
"Remove" to remove them from the report, or click "Remove 
All" to start over. 
 
Use the "Move Up" and "Move Down" buttons to control the 
order in which the channels appear. Your report will use this 
order to arrange the meter value columns across the page. 

 

Status Channels 
This page allows you to select the status channels that you 
want to include in the report. There are a couple of different 
ways that status channel values may appear in the report – this 
is configured on the next page. 
 
To add channels, select the site from the "Site" drop-down and 
then select the desired channel(s) in the "Channels" list. Click 
"Add" to add the selected channel(s), or click "Add All" to add all 
channels. 
 
The channels you have selected appear in the "Selected 
Channels" list. You can select channels in this list and click 
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"Remove" to remove them from the report, or click "Remove 
All" to start over. 

 

Channel Settings 

Status 
Your report can print status values using one or both of two 
methods: 

Print status when the status value changes  
Status messages will appear in the report as events. A message 
will print in the report showing the new status value and the 
time when it changed. Status channels that remain unchanged 
will not print at all.  

Print status every time the site is logged  
The report will show a line for each status value for every time 
when the site was logged. This works best only when a small 
number of status channels are included in the report.  

Meters 
Meter readings will appear all on one line (space permitting) 
with the exact time (to the second) of each reading. When a 
report comprises multiple sites, this can cause readings to 
"stagger" across multiple lines if the timestamps differ at all. 
Use one of the following options to optimize your report: 

Show all meter readings  
This is the default choice, and is recommended for single-site 
reports.  

Show no more than on reading for every ... minute(s)  
This option is recommended when including more than one site 
in a report. Meter readings that happen within the specified 
period of time are merged onto one line. If two sites log at 
slightly different times (for example, 1:00:05 and 1:00:42), this 
will prevent the meter readings from breaking up into more 
than one line on the report.   

 

Alarms and Events 
Select the types of events, alarms, and alarm severities that you 
want to include in the report. 
 
If you are using Alarm Relationships, use the "Show subordinate 
alarms" checkbox to control whether or not subordinate alarms 
are included in the report. If you are not using this feature, this 
checkbox is unimportant. 
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Coloring 
Certain kinds of data can be highlighted in color to help call 
attention to serious conditions. "Warning" conditions will 
appear in orange, and "critical" conditions will appear in red. 
 
Use the checkboxes on this page to specify what kinds of data 
should use this coloring feature. 

 

Headers and Footers 
If desired, enter a title for your report. This will appear at the 
top of the report in large print. 
 

You may also include page numbers, the date range of the 
report, and today's date (the date you are running the report, 
not the date you created it). For each of the options, you can 
specify where on the report/page it will appear. 

 

Additional Header/Footer Text 
To further customize the report to suit your needs, you can add 
additional text to the top and bottom of each page, the top of 
the first page, and the bottom of the last page. For example, 
you can a signature line, contact information, station details, 
etc. 

 

Scheduled Printing 
You can schedule your report to be printed or emailed 
automatically. 
 
For automatic printing, select the printer you want to use. 
 
For email, enter your email address, or a list of addresses 
separated by commas (engineer@example.com, 
gm@example.com). 
 
Select the date and time you want AutoPilot to print, and the 
frequency with which you want it to repeat the print job. Each 
time AutoPilot prints this report, it will read current values from 
the database. 
 
Note: When using automatic printing, it is strongly recommended 
that you not use a specific date range, as this would cause an 
identical report to print each time. 
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Finish 
Check "Preview this report" if you want to open a print preview 
now. 
 
Click Finish to save your report and close the wizard. 

 Scheduling Reports 

You can schedule reports to automatically print on a regular basis, or have AutoPilot automatically send 

a PDF copy of the report to one or more email addresses. 

You can configure the report scheduling options using the Report Wizard, or by right-clicking on a 

report in the Resources window and choosing "Schedule Report...". 

 

Report Scheduler dialog 
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Viewing, Printing and Emailing Reports 

 

 
AutoPilot requires that you have a default printer configured in Windows, 
even if you are only using print preview or PDF reports. 

Print Preview 

You can open a print preview in a separate window or directly in AutoPilot. 

To open a print preview window, select a report from the Resources window or Navigator and click 

"Print Preview" from the File menu. 

Top open a print preview directly in AutoPilot, double-click the report's icon in the Navigator. 

Note: You can configure AutoPilot to run a print preview from the Resources window using a single 

click by changing the options in the Options dialog. 

Saving to PDF 

You can save a report to a PDF file by first opening a print preview and then clicking the "Save to PDF..." 

button in the tool bar. 

 

"Save to PDF..." in the print preview tool bar. 

Print Preview Tool Bar 

 Print… Prints the report after prompting for a printer.  

 Save to PDF… Saves the report to a PDF file.  

Page # Displays the current page number. Typing a number in this field will jump to 
that page.  

 First Page Moves to the first page of the report.  

 Previous Page Moves to the previous page.  

 Next Page Moves to the next page.  

 Last Page Moves to the last page of the report.  

Size Displays the relative size of the report (% of full size). Only enabled when not 
using the "Auto" feature (see below).  

 Zoom In Increases the size of the report.  

 Zoom Out Decreases the size of the report.  

Auto When enabled, the report is automatically sized to fit the current window. 
Turning this feature off allows you to scale the report manually.  

 

Note: The report size settings available in the tool bar have no effect on the printed appearance of 

the report. 
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 Printing 

To print a report, select the report's icon in the Navigator and click "Print..." from the File menu. 

To print from a print preview window, use the "Print..." icon from the print preview tool bar (see above). 

To print automatically, see Scheduling Reports (PAGE 50). 

Emailing Reports 

AutoPilot can automatically email reports to one or more addresses. See Scheduling Reports (PAGE 50) 

for more information. 
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In Depth 

Program Options 

The Options dialog allows you to customize and enable many of the features in AutoPilot. Open the 

Options dialog by clicking "Options" from the Tools menu. 

 

General 

Time Synchronization 
To have AutoPilot synchronize the time on each remote 
control with the PC's clock, enable Time Synchronization. 
Specify the how often you want AutoPilot to perform this 
action. 
 
Note: AutoPilot will automatically compensate for any 
differences in time zone between the PC and the remote 
control. 

Connections 

Wait ... minute(s) between attempts to reconnect  
This setting adjusts how long AutoPilot waits before 
attempt to reconnect to a site after a connection was lost.  

Prompt to edit network if a site list change is detected  
For ARC Plus networks, AutoPilot can notify you if the site 
list has changed (sites were added or removed), and prompt 
you to use the ARC Plus Network Wizard to make any edits 
you may need as a result.  

Prompt Before Shutting Down 
If you enable this feature, AutoPilot will display a 
confirmation dialog when you close the program, giving you 
a chance to cancel if you were closing by mistake. 

 

Resources 

Navigator Selections 

Open default view after selecting a site in the Navigator  
When checked, AutoPilot will open the Default View for a 
site when you single-click on its icon in the Navigator.  

Open custom view after selecting in the Navigator  
When checked, AutoPilot will open a Custom View when you 
single-click on its icon in the Navigator.  
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Open print preview after selecting a report in the Navigator  
When checked, AutoPilot will automatically generate and 
display a print preview for a report when you single-click on 
its icon in the Navigator.  

Always Open Custom Views in a New Window 
When checked, all custom views will open in their own 
window, rather than in the main AutoPilot window. 

Custom Views in a New Window are Full Screen 
When enabled, AutoPilot opens Custom Views in a New 
Window in full-screen mode. 

Open a Custom View on Startup 
When enabled, AutoPilot will open the selected Custom 
View when the program starts. This is most commonly used 
for map or overview displays employed by network 
operation centers. 

 

Alarm Notification 
For more information on alarm notifications, see Alarm 
Notifications (PAGE 13). 

Alarm Sound 
Enable this feature if you want AutoPilot to play a sound file 
when it receives a new alarm from any site. 
 
Optionally, AutoPilot can loop the sound file. You can 
specify how long to wait (in milliseconds) between each 
iteration of the loop, and can have AutoPilot stop looping 
the sound after a certain number of minutes. 

Email Notifications 
Enable this feature if you want AutoPilot to send an email to 
the specified address(es) when a new alarm is received. 
 
To enter a list of addresses, separate each address with a 
comma (,) or semicolon (;). 
 
Note: This feature requires correct setup of email settings. 

Show New Alarms Dialog 
When enabled, AutoPilot will open the New Alarms dialog 
when a new alarm is received. 

Show Desktop Alert 
When enabled, AutoPilot will show a "desktop alert" when a 
new alarm is received. The desktop alert displays in the 
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lower right corner of the screen, and fades away after a few 
seconds. This is a useful way to display alarm notifications 
without interrupting the operator. 

 

Logging 

Log hidden channels  
When enabled, AutoPilot will log channels even if they are 
hidden. Otherwise, AutoPilot will not log data for hidden 
channels.  

Take a log after a critical alarm  
When enabled, AutoPilot will take a telemetry snapshot 
after it receives a critical alarm.  

Take a log after a warning alarm  
When enabled, AutoPilot will take a telemetry snapshot 
after it receives a warning alarm.  

Wait ... seconds after the alarm before logging  
Specifies the number of seconds AutoPilot will wait before 
taking a telemetry snapshot after receiving an alarm.  

Wait ... minutes before retrying a log if unable to take a log  
Specifies the number of minutes AutoPilot will wait before 
retrying to take a log on a site when the previous attempt 
was unsuccessful.  
 
Note: AutoPilot will always log the alarm. The settings in this 
section only affect telemetry logging when alarms occur. 

 

SQL Server 
See SQL Server Logging (PAGE 77). 

 

Text File Logging 
See Text File Logging (PAGE 75). 
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Security 

Password protect AutoPilot configuration  
When checked, AutoPilot will require a password to unlock 
configuration settings. For more information, see Security.  

Require ctrl+click to issue commands on default views  
When checked, AutoPilot will not issue a command from a 
Default View unless you hold down the Control key on the 
keyboard while clicking. AutoPilot will display a prompt if 
you click on a command without holding the Control key.  
 
Note: Requiring ctrl+click on Default Views does not affect 
Custom Views. However, each Custom View command can be 
configured to require ctrl+click in the Custom View Editor. 

 

Incoming Calls 
For more information, see Incoming Calls (PAGE 64). 
 
The Modems list displays all of the modems (if any) installed 
on your PC. Check the "Answer" column next to each 
modem that you want AutoPilot to use to answer incoming 
calls. 
  
If AutoPilot is configured to answer calls on a modem, that 
modem will be unavailable to other applications while 
AutoPilot is running. 
 
After answering a call, AutoPilot will automatically 
disconnect from the site to free the phone line. AutoPilot 
can either do so immediately after logging the site's alarms, 
or after the specified number of minutes. 
 
Note: When AutoPilot is configured to disconnect after a 
number of minutes, the software will first display a prompt 
giving you the option to remain connected. If you choose to 
remain connected, AutoPilot will keep the connection open 
until you manually disconnect. 

 

Email 
Email settings are required if you plan to use any of the 
email features in AutoPilot, such as emailing PDF reports. 
 
If you are unsure of your email settings, consult your 
network administrator or Internet Service Provider. 
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SMTP server  
Enter the IP address or host name of your email server.  

Port  
The port number used by your SMTP server. This is typically 
25.  

From address  
AutoPilot will use this for the "from address" field in email 
messages. This setting is not critical, but may affect how a 
spam filter treats messages sent by the software.  

Use authentication  
Check this box if your SMTP server requires a user name and 
password, and enter those values in the fields beneath the 
checkbox.   

 

Jet 
Jet options control the timing and behavior of Jet Active 
Flowcharts. 

Delay Jet startup for [n] seconds.  
When AutoPilot starts, it will delay running Jet Active 
Flowcharts for the specified number of seconds. Note that 
you can still run flowcharts manually before Jet starts 
running.  

Leave sites connected after use for [n] seconds.  
Jet will automatically connect to sites as needed. When Jet 
no flowcharts have required one of these sites for the 
specified number of seconds, Jet will disconnect from the 
site. Note that Jet will not disconnect sites that are 
connected automatically at startup or connected manually.  

Wait [n] ms before requesting new status/value.  
When requesting a new status or value from a site, Jet will 
wait the specified number of milliseconds before polling for 
data. This allows time for the site's readings to update.  

Allow up to [n] ms for Jet to receive a response from a site.  
Jet will wait up to the specified number of milliseconds to 
receive a response from a site when it polls for data. If the 
site does not respond in the time allowed, the flowchart will 
show an error.  

Poll for new data if readings are older than [n] seconds.  
When Jet requires site data, it will use the last known value 
from the site. If the last known value was received more than 
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[n] seconds ago, Jet will poll for new data. Note that Jet will 
always poll when using the "New Status" and "New Value" 
commands.   

 

Licensing 

To add license keys for AutoPilot add-ons, or to use a demo key, access the Licensing dialog from the 

Help menu. 

Note: The Licensing dialog is only used for add-ons and demos. You do not need to enter your remote 

control's authorization code in this dialog. 

 

Licensing Dialog 

To add a new license, click New License. AutoPilot will prompt you for your company name and license 

key. 

After you enter a license key it will take effect immediately (you do not need to restart the software). 

Note: Each license key you add to AutoPilot must be for the same company name. 

Although it is not normally necessary to remove a license key, you can do so by selecting the license 

from the list and clicking the Delete button. 
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Connectivity 

Connection Methods 

AutoPilot supports the following communication methods giving users an indication on the type of 

connection to the ARC systems.   

 Full Communication Full communication using a connection-oriented protocol (TCP).  

 Warp Communication Efficient communication using a connectionless protocol (UDP) via 
the Burk Technology Warp Engine protocol..  

No Communication No communication established with the site..  

 

Connecting and Disconnecting 

To connect to, or disconnect from, any site, select its icon in the Resources window or Navigator and 

use the appropriate option from the main menu, tool bar, or context menu (accessed by right-clicking 

on the site icon). These options are explained below: 

 Connect AutoPilot will connect using the primary connection settings.  

 Connect As… AutoPilot will prompt you for connection settings and a user name and 
password before connecting.  

 Connect to Backup AutoPilot will connect using the backup connection settings. AutoPilot 
will not switch to a primary connection when you manually establish a 
backup connection in this manner.  

 Disconnect AutoPilot will disconnect from the site. AutoPilot will not restore this 
connection after you manually disconnect.  

 

Note: If you have configured a site to not save the password, AutoPilot will always prompt for a 

password when connecting to that site. 

Connection Details Dialog 

The Connection Details dialog shows connection statistics and other data about your sites. To access 

this dialog, select a site in the Resources window or Navigator and click "Connection Details" from the 

File menu. 
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Connection Details dialog for an ARC Plus 

The Connection Details dialog shows the following parameters, depending on what remote control you 

are connected to: 

For All Remote Controls 

Connected via  The IP address or host name plus TCP port, COM port, or modem name and 
phone number used to connect to this site.  

Connected since  The date and time the connection was established.  

 

ARC Plus 

User  The user name that is logged onto this site.  

Serial number  The serial number of the remote control unit.  

Firmware version  The version of firmware running on the remote control unit.  

 

GSC3000/VRC2500 

Local unit  The I/O unit that AutoPilot is directly connected to. For VRC2500 sites, this 
is always unit 0.  

Connection Statistics 

Data Sent 

Total bytes  The total number of bytes sent from AutoPilot to the site.  

Total packets  The total number of packets sent from AutoPilot to the site.  

MS since last  The number of milliseconds since AutoPilot last sent a packet to the site.  

 

Data Received 

Total bytes  The total number of bytes sent from the site to AutoPilot.  
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Total packets  The total number of packets sent from the site to AutoPilot.  

Bad bytes  The number of bytes received from the site that AutoPilot could not parse 
into a valid packet.  

Bad packets  The number of packets received from the site that AutoPilot could not 
interpret as valid.  

MS since last  The number of milliseconds since AutoPilot last received a valid packet from 
the site 

Site Configuration Cache 

AutoPilot saves a copy of your ARC Plus, ARC Solo and GSC3000/VRC2500 site configuration files in its 

onboard cache. This allows AutoPilot to avoid downloading site configuration when it already has the 

current files. 

Although it is never necessary to do so, you can clear these cache files by selecting "Clear Saved Site 

Configuration" from the File menu. 

Note: After clearing the site configuration cache, you must restart AutoPilot before your ARC Plus or 

ARC Solo sites will respond to this change. 

Sync Configuration 

You can update AutoPilot’s cached configuration by right-clicking on a site in the Resources window or 

Navigtor and selecting “Sync Configuration” 

Backup Connections and Automatic Reconnection 

AutoPilot has several built-in options to help you stay connected to your sites 24x7. 

Terminology 

Primary Connection  Your primary connection to a site is the connection that you consider 
"normal", and will use in most cases.  

Backup Connection  A backup connection is an alternative method that AutoPilot can use to 
connect to a site. Often times this uses a dialup modem.  

Automatic Connection  A connection is automatic when AutoPilot connected without requiring 
an user interaction. When a site is configured to connect at startup, 
AutoPilot will automatically connect to it when the program starts.  

Connection Recovery  When a connection is lost, AutoPilot will first attempt to recover it. 
AutoPilot does this immediately after a connection loss. If the 
connection is recovered successfully, AutoPilot will not note a warning 
in the Application Event List.  

Retrying a Connection  Except under certain circumstances (explained below), AutoPilot will 
retry a connection periodically after a connection loss. This happens 
only after connection recovery is unsuccessful (see above).  

Manual Connection  Whenever you connect to a site by clicking one of the connect icons, you 
are connecting manually.  

Manual Disconnection  Whenever you disconnect from a site by clicking the disconnect icon, 
you are disconnecting manually.  
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Automatically Reconnecting After a Connection is Dropped 

AutoPilot will automatically reconnect to a site after a connection is lost. There are two phases to this 

process: 

1. AutoPilot will attempt to recover the connection immediately. If this is successful, AutoPilot 

will not log a warning in the Application Event List.  

2. AutoPilot will periodically retry the connection. The timing of this process is adjustable using 

the Options dialog.  

Note: If a connection recovery is unsuccessful, AutoPilot will log a warning in the Application Event 

List. AutoPilot will not log additional warnings if reconnection attempts are unsuccessful, as this 

would "flood" the log over a period of time. 

If a connection is restored but then lost again, AutoPilot will log a warning again. 

AutoPilot will not reconnect to a site under the following circumstances: 

• You manually disconnected from a site.  

• You connected to a site using "Connect As...".  

• Your site is configured to prompt for a password.  

Switching to a Backup Connection 

You can configure sites in AutoPilot to use a backup connection. AutoPilot will use the backup 

connection in the event that the primary connection is lost and cannot be restored. 

Restoring the Primary Connection 

Optionally, AutoPilot can periodically try to restore the primary connection. If this is not successful, 

AutoPilot will return to the backup connection. AutoPilot will repeat this process until the primary 

connection is successfully restored. 
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Automatic Connection Flowchart 

 

Password 

Saved?

Connected?

Backup 

Connection 

Enabled?

Connect to Backup

Primary 

Connection 

Restored

Wait

Unable to 

Restore 

Connection

No

Retry Primary 

Connection

Yes

Yes

No

Yes

Yes

No

Connection 

Loss

Retry Primary 

Enabled?

Remain on 

Backup 

Connection

No

 



 

64 
 

Incoming Calls 

 

Note: To configure your remote control to dial out to the AutoPilot computer, consult the 

documentation for your remote control. Visit www.burk.com for manuals and other documentation. 

If you have at least one modem installed on your PC, AutoPilot can answer incoming calls from your 

sites. 

To answer incoming calls, first enable the "Answer" ability on at least one modem using the Options 

dialog. 

 

The "Modems" list from the Incoming Calls section of the Options dialog. 

Note: You must make a connection to your site at least once in AutoPilot before it can accept an 

incoming call from that site. 

 
AutoPilot cannot answer incoming calls from sites if they are configured 
to prompt for a password. 

 

After answering an incoming call, AutoPilot will automatically disconnect from the site. You can 

configure AutoPilot to either disconnect immediately after taking a log, or after a period of time. 

 

Modem disconnection options from the Incoming Calls section of the Options dialog. 
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If you select the option to remain connected for a period of time, AutoPilot will prompt you to hang up 

or stay connected when the specified period of time has elapsed. 

 

The Disconnect Warning dialog gives you an opportunity to stay connected to a site that called into AutoPilot. 

If you do not press a button on the Disconnect Warning dialog, AutoPilot will disconnect when the 

timeout expires. 

If you choose to stay connected to the site, AutoPilot will not disconnect until you do so manually. 

Remote Control Specific Information 

ARC Plus 

PlusBus Status 

To access the PlusBus Status dialog, select an ARC Plus site in the Resources window or Navigator and 

click "PlusBus Status" from the File menu. 

 

PlusBus Status dialog 

Fields 

Device  The type of device on the PlusBus (Integrated Input Unit or Integrated Command 
Relay)  

Channels  The range of channel numbers this device is occupying.  

Status  The status of this device on the PlusBus (OK or Missing)  
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GSC3000/VRC2500 

Unit Properties 

To access the Unit Properties dialog, select a GSC/VRC Unit icon from the Resources window or 

Navigator and click "Unit Properties" from the File menu. 

 

Unit Properties dialog 

The following parameters are displayed on the Unit Properties dialog: 

Unit name  The name assigned to this unit.  

Unit number  The unit number (0–16)  

Unit type  What type of device this unit is (I/O 16, I/O 8, AC-4, AC-8, GT-4, GX-128, or 
OneConnect)  

Alias  The alias uniquely identifies this unit on the G-Bus.  

Firmware version  What version of firmware this unit is running.  

Modem version  If this unit is connected to a dialup mode, this field reports the version 
information as stated by the modem.  

MS since last update  The number of milliseconds since AutoPilot last received an update from 
this unit. 
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Warp Engine™ Polling 

The previous section described the process of establishing connections to ARC Plus and ARC Solo 

remote control units. While connected, all status and meter channels in the remote control unit are 

available for display in AutoPilot default views and custom views.  

 

Default View of a Connected Site 

The AutoPilot Warp Engine provides an alternative “connectionless” option for monitoring Version 5 

ARC Plus Touch or SL units with firmware 5.0.3.5 or later and ARC Solo units with firmware 1.0.29 or 

later. Warp Engine polling is fast, enabling real-time monitoring of up to 100 sites per second, with each 

site reporting as many as 32 status and/or meter values. Larger networks just take a little longer, for 

example polling up to 500 sites in 5 seconds.  

Warp Engine polling is efficient in its use of communications bandwidth. It uses very small packets, 

sending only required data and minimizing communications overhead. Polling 32 channels from 100 

sites requires only 37,800 bytes per second of IP capacity at the central site, and only 378 bytes per 

second at each remote site. If communications bandwidth is at a premium cost, it can be further 

reduced by selection of a slower poling rate.  

Note: The AutoPilot Warp Engine polls status and meter values, but does not permit control of 

command channels. To control a channel you must first reconnect to the site. 
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To configure Warp Engine polling, right-click a connected ARC Plus or ARC Solo site in the Resources 

window or Navigator -> click Warp Engine™ Polling. 

 

Warp Engine Polling Menu Choice 

The Configure Warp Engine Polling dialog box will be displayed: 

Configuring Warp EngineTM Polling 
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Click the Enable Warp Engine ™ Polling checkbox, select a Poll Rate and select the metering and status 

channels (up to 32 total channels) you want to poll with the Warp Engine. Warp Engine polling 

consumes very little bandwidth. However, if communications bandwidth is at a premium it can be 

further reduced by selecting a slower polling rate. 

Warp Engine uses connectionless polling. To enable it, you must disconnect from the site. From the File 

menu, select Disconnect or click on the disconnect icon   . Metering and status channels monitored 

at warp speed will appear in color. All others are shown in grey.  

 

TX-A FWD and TX-A RFL Warp Enging Polling Meters Shown in Color 

Click on the Download Alarm Details checkbox if a full alarm log for the site is desired. If this box is 

checked, each time Warp Engine detects that an alarm has occurred it will briefly establish a full 

connection to the site to download the alarm information. When the download is competed, the 

connection is automatically dropped and connectionless Warp Engine polling resumes.   

It is necessary to establish a connection to each ARC Plus or ARC Solo at least once prior to enabling 

Warp Engine polling for that system. This allows AutoPilot to download channel and configuration 

information from each system, and to establish credentials for secure Warp Engine communications.  

ARC Solo systems must be enabled for Warp Engine Polling via the ARC Solo web-browser interface. 

Navigate to the System->Warp Engine page and select the “Enable Warp Engine Polling” checkbox. 

See the ARC Solo User Guide for additional information. 

Note: Warp Engine polls all site alarm conditions regardless of which channels are being actively 

polled. 
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Alarm Management 

 Network Alarm List 

To view alarms from a single network only, right-click on the network's icon in the Resources window 

and select "Network Alarms". 

The network alarm list displays all the uncleared alarms for the selected network. 

 

Network Alarm List 

 Site Alarm List 

To view alarms from a single site only, right-click on the site's icon in the Resources window or 

Navigator and select "Site Alarms". 

The site alarm list displays all the uncleared alarms for the selected site. 

 

Site Alarm List 

Notifications and Sounds 

AutoPilot can notify you of new alarms in several ways, described below: 

Alarm List 

The Alarm List is the main place where AutoPilot displays information about alarms. New alarms are 

differentiated by their icon (). 

For more information on the Alarm List, see Alarms Overview (PAGE 10). 

 

Alarm List 
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New Alarms Dialog 

The New Alarms dialog, enabled using the Options dialog, will pop up whenever a new alarm occurs. 

 

New Alarm Dialog 

 

If there is more than one new alarm, the New Alarms dialog will show all of the new alarms. 

Clicking on an alarm in the list will display more information about the alarm at the top of the dialog. 

Clicking "Clear" will clear the selected alarm. 

New Alarm Desktop Alert 

A "desktop alert" is a small notification that appears in the lower right corner of the screen. The 

notification will automatically disappear after a few seconds. This kind of notification is a useful way to 

make an operator aware of new alarm condition with causing an interruption. 

 

New Alarm Desktop Alert 

Hovering over the desktop alert will prevent it from closing. 

Clicking the "Clear Alarm" icon ( ) in the lower left corner of the alert will clear the alarm. 

Sounds 

If desired, AutoPilot can play a sound when a new alarm is received. This option is configured in the 

Options dialog. 

 Alarm Relationships 

Alarm Relationships allow you to define cause and effect relationships between different alarm 

conditions. 
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For example, a loss of power may also cause a transmitter to power down, which in turn may cause a 

"low power" alarm. By defining the relationships between these conditions, AutoPilot can focus the 

operator's attention on the root cause condition, facilitating speedier problem resolution. 

To set up Alarm Relationships, click "Alarm Relationships..." in the Tools menu. 

 

Alarm Relationships dialog 

Every alarm relationship comprises one root alarm and one or more subordinate alarms. When a root 

alarm and subordinate alarm occur at the same time, AutoPilot will hide the subordinate condition. 

When a subordinate alarm occurs by itself (without the root alarm), AutoPilot will treat it normally and 

does not hide it. 

Note: You can still view subordinate alarm conditions in the Alarm List. See Alarms Overview (PAGE 

10) for more information. 

Cascading Alarm Relationships 

It is possible for root and subordinate alarms to "cascade", where a subordinate alarm is also a root 

alarm with its own subordinates. For example, an alarm for an off air condition may be a subordinate of 

a power loss alarm, but may itself cause a low power alarm. In this case the off air alarm is also a root 

alarm. 

To configure cascading alarm relationships, simply add the appropriate condition as a new root alarm 

and add its subordinates under it. AutoPilot will automatically hide both the original subordinate as well 

as its subordinate when the highest level root alarm is present. 

Alarm Window 

When related alarms occur, there may be some delay between the root alarm and the subordinate 

alarms that it causes. In some cases the subordinate alarms may occur after the root alarm, and in other 

cases they may happen before it. 

AutoPilot allows you to control the window of time around the root alarm in which subordinate 

conditions are considered to have been caused by the root alarm condition. This is called the alarm 

window. 

The pre-alarm window specifies the number of seconds before the root alarm during which time a 

subordinate alarm is counted as such. 

The post-alarm window specifies the number of seconds after the root alarm during which time a 

subordinate alarm is counted as such.  
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Alarm Relationships Dialog Tool Bar 

To add and edit alarm relationships, use following buttons found on the Alarm Relationships tool bar: 

 Save  Saves your alarm relationships.  

 Add Root Alarm Creates a new root alarm in the Alarm Relationships grid.  

 Add Subordinate Alarm Adds a new subordinate alarm under the selected root alarm.  

 Remove Root Alarm Removes the selected root alarm and all of its subordinates.  

 Remove Subordinate Alarm Removes the selected subordinate alarm.  

Close Closes the Alarm Relationships dialog.  

Alarm Relationships Grid Fields 

[Row Type]  This column identifies the type of row using an icon: 
 

 Root alarm 

 Subordinate alarm  
 

Network  Select the network containing the channel you want to use for this 
row.  

Site  Select the site containing the channel you want to use for this row.  

Alarm Type  Select the alarm type (status or a metering limit) that you want to use 
for this alarm definition.  

Channel  Select the channel whose alarm you are using for this row.  

Pre-Alarm Window (sec)  Enter the number of seconds that AutoPilot should use for the pre-
alarm window (Subordinate rows only).  

Post-Alarm Window (sec)  Enter the number of seconds that AutoPilot should use for the post-
alarm window (Subordinate rows only). 

 Alarm Muting 

The Alarm Muting dialog allows you to access the alarm muting feature of the ARC Plus. To open the 

Alarm Muting dialog, click "Alarm Muting" from the Tools menu. 

 

Alarm Muting dialog 
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To turn alarm on and off for the entire site, use the "Alarms enabled for this site" checkbox. 

To mute individual channels, place a checkmark next to the desired channel on the Meters or Status 

tab. 

Your settings will go into effect when you click OK or Apply. 

Logging 

AutoPilot logs the following types of data: 

• Telemetry (meter and status readings)  

• Status changes  

• Alarms  

• Events  

 

 Enabling Logging 

AutoPilot will always log alarms and events for all sites. Telemetry logging is enabled individually for 

each site, and can be enabled/disabled for the entire application. 

When logging for the application is disabled, AutoPilot will not log telemetry on any sites. When 

enabled, AutoPilot will log telemetry on all sites for which logging is enabled at the site level. 

To enable logging for AutoPilot, click "Enable Logging" from the Tools menu. 

To adjust logging settings for a site, right-click on the site's icon in the Resources window or Navigator 

and select "Configure Logging...". 

 

Logging Configuration Dialog 
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Logging and Connections 

If you are not connected to a site that is due to be logged, AutoPilot will automatically connect to the 

site for you. When AutoPilot is finished logging the site, it will automatically disconnect. 

Note: Logging will never cause AutoPilot to disconnect from a site that was already connected. 

 Logging on Demand 

To force AutoPilot to immediately take a log, click "Log Now" from the tools menu. 

Note: You must already be connected to a site to use the "Log Now" feature. 

Databases 

Onboard Database 

AutoPilot stores its logs and captures in the onboard database. AutoPilot always logs to the onboard 

database, even when other databases are enabled (see below). 

For more information on exporting and archiving your logged data, see Data Management (PAGE 82). 

The onboard log uses an SQLite Database format. When AutoPilot starts up, it will create this file 

automatically if it does not already exist. 

The onboard database file is located here: 

Windows 7 through 10: 

%AllUsersProfile%\Burk Technology\AutoPilot\Databases\Log.db 

 

 
While it is possible to open this file using a third party SQL browser, it is 
strongly recommended that you instead export your data or use Text File 
Logging. 
 

Never open this file while AutoPilot is running. 
 

Other Databases 

In addition to the onboard log, AutoPilot can optionally be configured to use one or both of the 

following types of logs: 

• Text File Logging  (SEE PAGE 75) 

• SQL Server Logging (SEE PAGE 77) 

Text File Logging 

In addition to using the onboard database, AutoPilot can log to a simple text file. This is often useful 

when integrating log data with 3rd party applications. 
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Text File Logging will create a log file in the following location: 

Windows Vista and Windows 7 through 10: 

%AllUsersProfile%\Burk Technology\AutoPilot\Logs 

Windows XP: 

%AllUsersProfile%\Application Data\Burk Technology\AutoPilot\Logs 

Each site will have its own file. The file name is generated automatically, and follows the following 

format: 

[Network Name] - [Site Name] ([Unit ID]) 

When AutoPilot automatically archives a Text File Log (see below), the archive file will be stored in the 

following location: 

Windows Vista and Windows 7 through 10: 

%AllUsersProfile%\Burk Technology\AutoPilot\Logs\Archive 

Windows XP: 

%AllUsersProfile%\Application Data\Burk Technology\AutoPilot\Logs\Archive 

To enable and configure Text File Logging, use the Options dialog.  

 
You must restart AutoPilot after enabling or disabling Text File Logging 
before your changes will go into effect. 

 

 

Text File Logging Settings in the Options Dialog 

The following parameters are available: 

Enable text file logging  Use this checkbox to turn Text File Logging on and off 
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Comma separated values  Select this option to have AutoPilot write to the text file using 
commas to separate each field.  

Tab separated values  Select this option to have AutoPilot write to the text file using 
tabs to separate each field.  

 

File Maintenance Options 

Never delete or archive log files  AutoPilot will not perform any file maintenance tasks. You may 
delete/archive files manually in Windows if desired.  

Automatically delete log files  AutoPilot will delete your log files according to the specified 
schedule.  

Automatically archive log files  AutoPilot will move your log files to the archive location (see 
above) according to the specified schedule.  

Delete / archive files after...  AutoPilot will delete or archive files after they have reached the 
specified age.  

 

 
File maintenance is strongly recommended. Letting a Text File Log grow 
too large may cause performance problems in AutoPilot or in 3rd party 
applications. 

 

SQL Server Logging 

In addition to using the onboard database, AutoPilot can log to a server running Microsoft SQL Server. 

This is often useful for organizations running multiple AutoPilot logging computers, and can also be 

used to integrate AutoPilot's logged data with other databases used throughout the operation. 

For information on what tables and fields are included in the AutoPilot SQL Server database, see 

Database Schema (PAGE 116). 

To enable and configure SQL Server Logging, use the Options dialog. 

 
It is strongly recommended that you contact your database administrator 
before configuring SQL Server Logging in AutoPilot. 

 

 
You must restart AutoPilot after enabling or disabling SQL Server 
Logging before your changes will go into effect. 
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SQL Server Logging settings in the Options dialog 

The following parameters are available: 

Log using SQL Server  Check this box to enable/disable SQL Server logging. 

Server address  The host name or IP address of the computer running 
Microsoft SQL Server.  

Database  The name of the AutoPilot database on your SQL Server. Use 
the drop-down list to select an existing AutoPilot database.  
 
See below for instructions on how to create a new database.  

Use integrated Windows security  Select this option if your Windows user account has 
permission to write to the AutoPilot database.  

Specify a user name and 
password  

Select this option and enter your user name and password to 
use a specific account on the SQL Server. 

 

Note: Your account must have permission to read and write to the AutoPilot database. Consult your 

database administrator to make sure you have the correct permissions. 
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Creating a New Database on the SQL Server 

There are two ways you can create a new database on the SQL Server for AutoPilot. 

Let AutoPilot Create a Database 

1. Open the SQL Server tab in the Options dialog (see above).  

2. Enter your server address and security information.  

3. Enter the desired name for the AutoPilot database in the "Database" field.  

4. Click the "New" button. AutoPilot will automatically create your database.  

A message box will confirm that this was successful, or state what error caused it to fail. 

Use the Supplied SQL Script 

AutoPilot ships with a .sql script that a database administrator can use to create a new database. The 

script is found here: 

%ProgramFiles%\Burk Technology\AutoPilot\AutoPilot.sql 
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Captures 

The Captures feature, available on ARC Plus Touch and SL units with firmware 5.0.8.1 or newer, allows 
you to configure the ARC Plus to store periodic captures (snapshots) of a specified range of channel 
values locally on The ARC Plus. You can create a download schedule on any AutoPilot system to 
automatically retrieve the captures. Captures and logs are stored in the same onboard database and are 
displayed in the Logged Data View. 

Enabling Capture Downloading  

Select “Enable Logging” from the Tools menu.  

 

Tools>Enable Logging 

 

If you are not connected to a site that is due for a download, AutoPilot will automatically connect to the 

site for you. When AutoPilot is finished downloading from the site, it will automatically disconnect.  

Configuring the Download Schedule 

1. Select “Configure Logging” from the Edit menu. 

2. Enable the “Download Captures from this site” checkbox. 

 

Edit>Logging 

3. Specify the download “Interval” (the frequency, in minutes or hours, at which AutoPilot will 

download its next captures from the ARC Plus).  

4. Specify the “Next download” (the time of day when AutoPilot will download its next set of 

captures).  

5. Click “OK”. 
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Note: If AutoPilot fails to take a log or download captures, it waits 10 minutes and then tries again. 

You can configure the waiting interval in Tools > Options > Logging.  

Taking an Immediate Capture 

In addition to the captures scheduled to be performed automatically on the ARC Plus, you can perform 

an immediate capture from the remote AutoPilot system. This capture is stored on the ARC Plus 

system and downloaded to AutoPilot as specified in the download interval  

 

 
Tools>Take Capture 

Viewing Captures 

Captures appear in the Logged Data View. See Logged Data View(PAGE 7). 
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Data Management 

 Exporting Data 

AutoPilot has a built-in export feature that allows you to export your logged data in a variety of 

different formats, each suitable for analysis in 3rd party applications. 

To export your data, click "Export Logged Data..." in the Tools menu. 

 

Export dialog 

The following options are available on the Export dialog: 

Format  AutoPilot supports the following formats: Excel, CSV (comma separated values), 
Tab (tab delimited values), and XML (extensible markup language).  

Data  Select the database table that you want to export: Telemetry, Alarms, Events, or 
Status Changes.  

Network  Choose the network whose data you want to export, or choose "All Networks".  

Site  Choose the site whose data you want to export, or choose "All Sites" 

Start date  Check the "Start date" checkbox and select a date if you want to export data only 
from dates on or after the selected date.  

End date  Check the "End date" checkbox and select a date if you want to export data only 
from dates on or before the selected date.  

Convert times 
to local time 
zone  

When this option is checked, AutoPilot will convert all timestamps to use the 
local time zone instead of UTC.  

 

Note: Exporting data does not remove it from the database. 
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 Archiving Data 

Over time, and depending on the number of sites you have added to AutoPilot, your onboard database 

may grow very large. Archiving data will remove it from the database and store in an archive file that 

you can access later. 

 
While the technical limit to the size of the database is 2GB, it is highly 
recommended that you periodically archive your data to optimize 
performance. 

  

To archive your data, click "Archive Logged Data..." in the Tools menu. 

 

Archive Data dialog 

Enter the date that you want to use to archive your data. Any data older than this date will be removed 

from the database and stored in the archive. 

Archived data is stored in XML format. AutoPilot will prompt you for the location where you want to 

store this file. 

Security 

Security Overview 

Password Encryption 

There are several places throughout AutoPilot where the software will prompt you for a password. 

AutoPilot never stores your passwords in "plain text". Passwords are encrypted using standard 

encryption methods whenever it is necessary to save to a file. 

Remote Control Permissions 

Your remote control has built-in security mechanisms, varying by model. Remote control security 

prevents unauthorized users from reading your data or issuing commands. 

Maintenance Mode 

Your remote control also has a "maintenance mode" or "remote/local" mode feature. This feature locks 

out remote commands for safety reasons during maintenance operations. The remote control will not 

permit AutoPilot to issue commands when in maintenance mode. 
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Note: AutoPilot will gray out commands that are unavailable due to insufficient permissions or 

maintenance mode. 

Even if a command were to appear available, the remote control itself would not allow AutoPilot to 

issue the command. 

 Locking AutoPilot Configuration 

If desired, you can password protect AutoPilot's configuration options. This is useful to prevent 

operators from making undesired changes. 

To enable this feature, use the "Security" tab in the Options dialog. 

Once you have enabled password protection and set a password, click "Lock AutoPilot Configuration" in 

the File menu to lock or unlock the configuration. 

 

Unlock Configuration password prompt 

 Application Event List 

AutoPilot logs various activities using the Windows Application Event Log. While you can access this log 

directly in Windows, AutoPilot makes it available in the program as well. 

To access the Application Event List, click "Application Event List" from the View menu. 

 

Application Event List 
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To see more information about an event, double-click on its entry in the event list. 

 

Application Event details 

Note: The Application Event dialog includes a "Copy" button that will copy the event details to the 

clipboard. You can then paste this information into a file or email. 

There are three types of events logged in the list: 

 Information Information events are a record of some of the regular operations that AutoPilot 
performs. These events are normal, and do not indicate any kind of a problem.  

 Warning Warning events indicate that an operation was unsuccessful, due to foreseeable 
circumstances (such as a connection loss). 

 Error An error condition is an abnormal failure. Under normal circumstances, error 
conditions should never occur.  

  

Note: AutoPilot will notify you of new Error conditions by showing an icon in the Status Bar. 

Migration 

Migrating your AutoPilot installation from one computer to another – or cloning your configuration for 

use on second PC – is relatively easy. All of your files are stored in one folder on the computer: 

Windows Vista and Windows 7 through 10: 

%AllUsersProfile%\Burk Technology\AutoPilot 

Windows XP: 

%AllUsersProfile%\Application Data\Burk Technology\AutoPilot 

Note: By default, %AllUsersProfile%\Application Data is a hidden folder in Windows XP. 

To completely clone your installation onto another computer, simply copy the files from this folder 

onto the new computer. If desired, you may copy only certain files. See below for more information. 
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You must still install AutoPilot on your new computer. Copying this 
folder does not install the software for you. 

 

AutoPilot Files and Folders 

Folders 

Cache  The cache folder stores local copies of your site configuration. These files can be 
safely deleted or omitted during data migration.  

Custom Views  This folder contains all of your Custom View files 

Databases  This folder contains your onboard logging and captures database (Log.db). If you 
delete or omit this file, AutoPilot will create a new one on startup.  

Jet  This folder contains your Jet™ Active Flowcharts for AutoPilot as well as your 
Virtual Channels. 

Licensing  This folder contains your licensing information for add-ons and demos. 

Logs  This folder contains your Text File Logs (if enabled).  

Reports  This folder contains your report files.  

Settings  This folder contains various files that store settings, sites, etc. See below for more 
details.  

 

Settings Files 

The following files are found in the Settings folder (see above). If you delete one of these files, or omit it 

during data migration, AutoPilot will create a new – blank – copy. 

cfgsec.dat  This file stores a one-way hash of your configuration password (if you 
have set one). See Security for more information.  

IncomingCallSettings.xml  This stores your incoming call handling settings. Because computer-
specific modem information is stored in this file, it may not be useful 
if copied to a new computer (although doing so is harmless).  

NetworkDevices.xml  This stores your Network Devices.  

Networks.xml  This stores your site data.  
 
This is the most critical file to copy when cloning your setup.  
 

SubordinateAlarms.xml  This stores your Alarm Relationships configuration.  

Network Names 

If you plan to share Custom Views or other site-related data between multiple computers, it is 

important that you use the same network name on each computer for your sites. AutoPilot uses 

the network name to identify your sites. 

Note: You can rename a network within AutoPilot. AutoPilot will display a prompt asking if you want 

to update your Custom Views, etc. 

  



 

87 
 

Jet 

 Jet Active Flowcharts 

Jet Active Flowcharts allow you to describe automatic remote control functionality using simple, easy 

to read flowcharts. 

Licensing 

To purchase a license for Jet, please contact Burk Technology at 978-486-0086, or via email at 

sales@burk.com. 

Active Flowcharts for AutoPilot 

Jet™ Active Flowcharts for AutoPilot allow you to control any site or Network Device in AutoPilot. 

To run an Active Flowchart in AutoPilot, use the Jet Status window.  

 
Jet Active Flowcharts for AutoPilot will only run when AutoPilot is 
running. 

Starting Jet 

To start Jet, select Jet from the Tools menu in AutoPilot. 

Note: If you have not installed your license for Jet Active Flowcharts, please do so now. 

See Licensing (PAGE 58) for more information. 

 Create a New Flowchart 

From the Jet Designer, select New from the File menu. Jet will prompt you for a flowchart target. 

Choose the "Run this flowchart in AutoPilot" option. 

 

Flowchart target 
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 Saving the Flowchart 

After designing your flowchart, click Save from the File menu to save your flowchart. Enter a file name 

for this flowchart. AutoPilot will use the file name to identify this flowchart.  

 
Jet will only run flowcharts from the Jet directory. Do not save flowcharts 
in any other location. 

 

 
Saving a flowchart that is running will cause Jet to stop the flowchart. If 
the flowchart is not scheduled to run, you will need to restart it manually. 

 Opening an Existing Flowchart 

To open an existing AutoPilot Active Flowchart, click AutoPilot Active Flowchart... from the Open 

submenu under the File menu. 

 Calendars 

You can schedule flowcharts to run at different calendar times. Jet allows you to define multiple 

calendars. To add, remove or edit a calendar, click Manage Calendars... from the Tools menu in Jet. 

 

Jet Calendars 

 New Calendar Creates a new calendar.  

 Save Saves changes made to the selected calendar.  

 Delete Calendar Deletes the selected calendar.  

Calendar Select a calendar from the drop down list to display it in the editor.  

Close Closes the calendar editor.  

 

Note: Jet calendar times are always in Standard Time for the time zone configured on the PC. 
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 Error Handling 

To specify how Jet should respond should a flowchart experience an error, click Error Handling... on the 

File menu. 

 

Error Handling 

Options 

Stop the flowchart  If the flowchart experiences an error, Jet will stop the flowchart. Jet will not 
run the flowchart again unless it is scheduled to run later, or if you run it 
manually.  

Restart the flowchart  If the flowchart experiences an error, Jet will restart the flowchart after 
waiting for the specified number of seconds.  

Email an error report  When this option is checked, Jet will email the specified email address if 
the flowchart experiences an error. 

 

Active Flowcharts for ARC Plus and ARC Solo 

Jet™ Active Flowcharts for ARC Plus run as macros on the ARC Plus. You can run flowcharts on the ARC 

Plus the same way you can run macros (AutoPilot, front panel, ESI, RSI, Web Interface, etc). 

 
Active Flowcharts on the ARC Plus can not be edited using the Macro 
Editor in AutoLoad Plus.  

 

Note: Jet requires ARC Plus firmware 2.2 or newer. To obtain the latest ARC Plus firmware, visit 

www.burk.com. 

Jet™ Active Flowcharts for ARC Solo are run as macros on the ARC Solo. You can run flowcharts on the 

ARC Solo from AutoPilot or from the ARC Solo RSI or Web Interface. 

Starting Jet 

To start Jet, select Jet from the Tools menu in AutoPilot. 
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Note: If you have not installed your license for Jet Active Flowcharts, please do so now. Licensing is 

not required for creation of Active Flowcharts on the ARC Solo. 

See Licensing (PAGE 58) for more information. 

 Create a New Flowchart 

From the Jet Designer, select New from the File menu. Jet will prompt you for a flowchart target. 

Choose the "Run this flowchart on an ARC Plus" option or the "Run this flowchart on an ARC Solo" and 

select the network and site for which you want to create a new flowchart. 

 

Flowchart target 

 Saving the Flowchart 

After designing your flowchart, click Save from the File menu to save your flowchart. Select the macro 

location where you want to save the flowchart, and give it a name. 

 

Save a flowchart to an ARC Plus 
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     Opening an Existing Flowchart on ARC Plus or ARC Solo 

To open an existing Active Flowchart, click ARC Plus or ARC Solo Active Flowchart... from the Open 

submenu under the File menu. Select the network and site, and then select the desired flowchart. 

 

Open a flowchart on an ARC Plus 

 

Open a flowchart on an ARC Solo 

 

Designing Active Flowcharts 

Flowchart Components 

Flowchart components are objects that you can add to the flowchart's canvas. The following 

components are available for use in Jet: 

 Start Flowchart  Specifies the beginning of a flowchart. All flowcharts must have a start.  

 End Flowchart  Specifies where the flowchart stops running. Flowcharts may have more than 
one end, or no end if execution should continuously.  

 Action  A flowchart action performs an operation and then moves to the next object. 
Actions always have one output.  

 Conditional  A conditional moves to either of two objects, depending on whether the 
condition evaluates to true (T) or false (F). Conditionals always have two 
outputs.  

 Line Joint  Line joints are used to route flowchart lines around the canvas of the 
flowchart. Using line joints is optional. Line joints do not affect the 
functionality of a flowchart.  

 Junction  Junctions allow multiple output lines to converge on a single target. Junctions 
are useful for making the intention of the flowchart clear, but do not affect 
functionality. Using junctions is optional, as multiple lines can be connected to 
a single target without using a junction.  
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Adding and Connecting Components 

Adding Components to the Canvas 

To add a component to a flowchart, simply drag it from the Toolbox and drop it onto the canvas. You 

can click and drag a component on the canvas to move it around, and use the sizing handles to resize it 

as desired. 

Note: Remember to add a Start object to your flowchart. All flowcharts require a start. 

Drawing Lines to Connect Components 

Drawing lines between flowchart components instructs the flowchart to execute conditions and actions 

in the desired order. 

To draw a line connecting two components, hover over the first component to bring up the connection 

arrows. 

 

Connection arrows 

Note: One connection point cannot serve as both an input and an output. When used as inputs, 

multiple connections may share the same point. When used as outputs, each connection can only 

support one connection. 

Flowchart lines may start and end at any of the arrow positions displayed. Hover over the desired arrow 

and note that it turns dark red to indicate that it is selected. To begin drawing a line, click and hold the 

mouse, then drag the mouse to the desired target object. Hover over the target object (with the mouse 

button still held down) to display its input selection arrows. Hover over the desired arrow (note that it 

turns dark red) and release the mouse button. Jet will draw a line between the two objects using the 

points you selected. 
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Connected flowchart objects 

Note: If desired, a line can connect an object back to itself. This instructs the flowchart to execute the 

component continuously in a loop. Carefully consider what you want the flowchart to do when using 

this technique. 

Connecting Conditionals 

Conditionals always have two outputs: one for the "True" condition, and one for the "False". The first 

line you draw out of a conditional is for the True condition. True conditions are identified with a "T", and 

false conditions with an "F". 

 

The "T" and "F" connections for a conditional 
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Configuring Component Settings 

Each action and conditional component is configurable for a wide variety of operations. To configure a 

component, click on it to select it, and use the Properties tool window. 

 

Flowchart component properties 

Once you have configured the component's properties, it will show a description of its settings on the 

canvas. 

 

A flowchart component with its properties set 

Using Line Joints and Junctions 

Line Joints 

Routed lines on the flowchart canvas automatically create a path between two objects. There may be 

times when this path conflicts with other objects on the canvas, or is otherwise undesirable. 

The line joint allows you to route a line along a specific path. To use the line joint, drag and drop it onto 

the canvas and connect it as you would any other component. When the line is selected, the line joint 

will display a small green dot. When the line is not selected, the line joint will be invisible. 
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A line joint 

Note: The line joint does not add any functionality to the flowchart. 

Note: Jet will automatically create line joints for you when you are drawing lines if you drop the line 

on the canvas instead of connecting it to another component. 

Junctions 

Junctions are a convenient way to connect the output lines from multiple components to a single input. 

The junction does not add any functionality to the flowchart — it simply makes the intention more 

clear. 

 

A junction 

Note: Using junctions for many-to-one connection is not required. If desired, you can connect multiple 

objects directly to a single destination. The junction is purely for convenience and readability. 
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Line Types 

Jet supports two types of lines for connecting components together. To choose a line type, select it 

from the Tools menu. 

 Straight Line A straight line is drawn directly from one point to another.  

 Routed Line Routed lines use right angles to draw a path between two objects. 

 Scheduling Active Flowcharts 

To schedule a flowchart, select the Schedule... option from the File menu. 

 

Schedule 

Run on demand  The flowchart will only run when executed specifically. It will not 
run automatically.  

Run at startup  The flowchart will run when the system starts up.  

Run at an interval  The flowchart will run periodically at the specified interval.  

Schedule for a specific time  The flowchart will run daily at the specified time.  

Schedule for a calendar time  The flowchart will run daily at the specified calendar time.  

 

Note: Active Flowcharts for AutoPilot include an additional option to select from multiple calendars. 
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 Jet Status 

The Jet Status window in AutoPilot allows you to run, stop and view the status of your Active 

Flowcharts for AutoPilot. 

 

Jet Status 

Note: The Jet Status window only shows Active Flowcharts for AutoPilot. Active Flowcharts for ARC 

Plus and ARC Solo appear as Macros in the Macro List. 

Tool Bar Icons 

 Run Runs the selected Active Flowchart.  
 

 Stop Stops the selected Active Flowchart. 

 New Create a new Active Flowchart for AutoPilot.  
 

 Edit Opens the selected Active Flowchart in the editor. 

 

Context Menu Icons 

In addition to the tool bar icons above, the following items are available by right-clicking on a flowchart 

in the status window. 

 Delete Deletes the selected Active Flowchart.  

Rename Allows you to rename the selected Active Flowchart.  

 Properties Displays the properties of the selected Active Flowchart, including the time the 
flowchart last ran, and additional information about the most recent error the 
flowchart reported (if any).  
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Status Icons 

When a flowchart is running or scheduled to run, the status window will display an icon next to the 

flowchart to indicate its status. Flowcharts that are not running and not scheduled to run will display no 

icon. 

 Running The flowchart is currently running.  

 Reading Data The flowchart is reading data from a site.  

 Waiting The flowchart is running a Wait command.  

 Scheduled The flowchart is not running, but is scheduled to run in the future.  

 Error The flowchart reported an error on its last execution. Right-click on the 
flowchart and choose Properties for more information. 

 Virtual Channels 

Overview 

Virtual Channels allow you to create new channel values using real channels, operators and functions. 

Virtual Channels are a useful way to add calculated channel data such as VSWR and efficiency, as well 

as complex status indicators that combine the values of multiple channels and conditions. 

Licensing 

Virtual Channels are a part of Jet™. To purchase a license for Jet, please contact Burk Technology at 

978-486-0086, or via email at sales@burk.com. 

 Virtual Channel List 

The Virtual Channel List displays the name and live value of each Virtual Channel. From this list you can 

add, edit, delete and rename Virtual Channels. 

The Virtual Channel List, by default, is docked to the right side of the screen and set to auto hide. 

 

Virtual Channel List 
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 Creating a New Virtual Channel 

To create a new Virtual Channel, click the New toolbar button on the Virtual Channel List. 

A Virtual Channel is defined using real channels, constant values, operators and functions. You can type 

a Virtual Channel definition directly into the editor if you are already familiar with the syntax. 

Otherwise, use the operator buttons and function list to build your channel. 

For a complete description of Virtual Channel syntax, please see the Virtual Channel Syntax Reference 

(PAGE 121). 

Virtual Channels are interpreted as either Meter or Status channels. Use the option buttons for Meter 

and Status on the Virtual Channel Editor to select the appropriate channel type. Meter channels are 

reported as a numeric value. Status channels are reported as a Boolean (true/false) value. 

Note: To see the value of your Virtual Channel while you are editing it, click the Test button. 

When you have completed your Virtual Channel definition, click the Save button. The Virtual Channel 

Editor will prompt you to name your new channel. 

 

Virtual Channel Editor 

 Editing a Virtual Channel 

To edit an existing Virtual Channel, select it in the Virtual Channel List and click the Edit button on the 

toolbar. AutoPilot will open the channel in the Virtual Channel Editor, allowing you to make changes to 

its definition. 

Renaming a Virtual Channel 

To rename an existing Virtual Channel, right-click on the channel in the Virtual Channel List and select 

Rename from the context menu. Each Virtual Channel must have a unique name. 
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 Deleting a Virtual Channel 

To delete a Virtual Channel, right-click on the channel in the Virtual Channel List and select Delete from 

the context menu.  
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Reference 

Custom Views 

Controls 

Command Buttons 

 Command Button (See also Password Command Button, below) 

A standard command button. 

 

 LED Button 

A command button with an embedded LED. 

 

 LED Button (2 Lines Centered) 

A commands button with an embedded LED and a 2 line centered caption label. 

 

 LED Button (2 Lines) 

A commands button with an embedded LED and a 2 line caption label. 

 

 Password Command Button 

This command button requires a password for activation. A password must be entered for this control 

using the Custom View Editor. When the Password Command Button is clicked in a Custom View, a 

password confirmation dialog box is displayed requiring entry of the correct password before the 

corresponding action is taken.  
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 Sticky Button 

The Sticky Button remains "stuck" down when its status condition is "ON". This control works best when 

used in mutually exclusive pairs. 

 

General 

 Camera Picture (See also Video, below) 

Embeds a web cam picture in your Custom View.  

 

 Clock 

A simple clock with adjustable time zone offset and flexible display format. 

 

The Format property can be used to define how the date and/or time will be displayed by the Clock 

object. The default format, shown in the image above, is displayed if the Format property is left blank. 

This format could also be specified by entering the following  text string for the Format property: “h/m/s 

tt” where “h” specifies the current hour shown as 1 through 12, “m” specifies the current minute shown 

as 0 through 59, “s” specifies the current second shown as  0 through 59, and “tt” specifies the display of 

AM or PM.  

A different display format can be specified by combining elements from the table below into a text 

string defining the desired representation of date and/or time, and entering that string for the Format 

property. 

Format Specifier Description 

"d" The day of the month, from 1 through 31. 

"dd" The day of the month, from 01 through 31. 

"ddd" The abbreviated name of the day of the week. 

"dddd" The full name of the day of the week. 

"h" The hour, using a 12-hour clock from 1 to 12. 

"hh" The hour, using a 12-hour clock from 01 to 12. 

"H" The hour, using a 24-hour clock from 0 to 23. 
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Format Specifier Description 

"HH" The hour, using a 24-hour clock from 00 to 23. 

"m" The minute, from 0 through 59. 

"mm" The minute, from 00 through 59. 

"M" The month, from 1 through 12. 

"MM" The month, from 01 through 12. 

"MMM" The abbreviated name of the month. 

"MMMM" The full name of the month. 

"s" The second, from 0 through 59. 

"ss" The second, from 00 through 59. 

"t" The first character of the AM/PM designator. 

"tt" The AM/PM designator. 

"y" The year, from 0 to 99. 

"yy" The year, from 00 to 99. 

"yyyy" The year as a four-digit number. 

":" The time separator. 

"/" The date separator. 

 Custom View Extents 

Set the aspect ratio for auto scaling of custom views. 

 

 Label 

A basic, general purpose label control. 

 

 Line 

Draws a straight line. 
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 Map 

A resizable map. State maps are available, as well as a map of the US. 

 

 Picture 

Embeds an image in your custom view. The image is saved with your Custom View, and will work even 

if the view is loaded on another computer. 

 Text File 

Shows the contents of any text file on your computer. 

 

Video 

The Video object displays the video stream from a webcam using the RTSP protocol.  

 

The Connectionn properties for this custom view element are as follows: 

Host  The IP address or URL of the camera  
Password  The password assigned to the camera 
Path This can be left blank unless required by the camera 
Port The rtsp port number used by the camera. Setting to -1 applies the default value of 

554. 
Query This can be left blank unless required by the camera 
Scheme Must be set to rtsp 
Username The username assigned to the camera 
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 Weather Map 

A weather map from the National Weather Service. Can be displayed as a static image or animation. 

 

 Web Page 

The Web Page control allows you to embed a web page directly in your Custom View. 

 Web Picture 

Embeds any image from a web site. Can be set to periodically refresh. 

Meters 

 Angular Meter 

A classic gauge. 
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 Angular Meter (Advanced) 

A classic gauge with additional Labels and Meter properties. 

 

 Bar Meter 

Displays a meter on a linear meter that fills in with color to indicate value. 

 

 Chart 

A strip chart control that supports multiple lines. See Using Charts (PAGE 42) for more information. 

 

 

 Compass 

Use the compass control to display direction. 
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 Linear Meter 

Displays a meter value on a linear indicator. Can be oriented horizontally or vertically. 

 

 Nominal Bar 

The nominal bar displays a meter value relative to a specified nominal value. This allows an operator to 

quickly determine what parameters are out of tolerance. 

 

 Power Meter 

Displays power using both W (or kW) and dBm. 

 

 Right Angle Meter 

A gauge-style meter starting on the left and spanning 90°. 

 

 Text Meter 

A simple non-graphical meter display. 
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 Thermometer 

Displays temperature values. 

 

 Trend Arrow 

Indicates whether a meter channel is trending up or down, or is steady. 

 

 VSWR Meter 

The VSWR meter automatically calculates VSWR using forward and reflected power. 

 

Network Management 

 Network Device 

Represents a network device. The color of the icon indicates the state of the device. Icons are available 

for a wide range of standard equipment. 

 

 Network Device Label 

Displays the name of a Network Device. The background color represents the status of the device. 

 

SNMP String 

Displays the text received from a text parameter on an SNMP agent. 
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 SNMP Up Time 

Displays up time data received from an SNMP agent, formatted as a duration. 

 

Shapes 

 Rectangle 

A rectangle or square. 

 

 Oval 

An oval or circle. 

 

 

Specialized 

Summary Site Status and Summary Group Status Controls 

The Summary Site Status and Summary Group Status controls make it possible to display a summary of 

alarm conditions for a single site, or for a group of sites, in a single graphical element. These graphical 

elements use a color grid of consisting of one to four colors, depending on the type of alarms associated 

with the group. The four color categories are as follows: 

• Green – No critical or warning alarms 

• Yellow – Warning alarms 

• Red – Critical alarms 

• Grey – Site is not communicating with  AutoPilot 
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Sites 

The Summay Site Status control shows the name of the site and a color bar that represents one of five 

states, as described in the following table. If the site has critical or warning alarms, the total number of 

alarms is shown in the red or yellow box. 

Green – Site is connected with no 
critical alarms or warnings. 

 
Grey— Site is not communicating 
with AutoPilot. 

 
Yellow – Site has warning alarms.  

 
Red – Site has critical alarms. 

 

Split red/yellow – Site has critical 
alarms and warnings. In this 
example, the site has 7 critical 
alarm and 2 warnings. 

 
 

Groups 

The Summary Group Status control shows the group name on the top line. Below the text, a color bar 

represents the group states along with the number of sites in a group (in cases where a single number 

appears). For alarms, (yellow and red), the number of alarms appears, followed by the number of sites 

that are reporting the alarms.  

To get detailed information on a group, click its control. 

Green – All sites are 
communicating, with no alarms 
or warnings. 

 
Grey— None of the sites in the 
group are communicating with 
AutoPilot. 
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Yellow – At least one site in the 
group has one or more warning 
alarms.  In this example, three 
alarms are occurring at one site. 

 
Red – At least one site in the 
group has one or more critical 
alarms. In this example, a total of 
four critical alarms are occurring 
at two sites.  

Red/Yellow – At least one site in 
the group has one or more critical 
alarms and at least one site has 
one or more warning alarms. In 
this example, one site is reporting 
a critical alarm and three warning 
alarms are occurring among two 
sites. 

 

 

When some of the sites in the group are not communicating with Autopilot, the right-most (grey) 

column displays the number of sites that are not communicating. The two-left columns display green, 

red and yellow columns, as described in the previous table.  

 

In this example, the following conditions exist: 

• Three sites (grey) are not communicating with Autopilot 

• One site (red) is reporting a critical error. 

• Three warning errors are occurring between two sites (yellow). 

To add a Summary Site Status  or Summary Group Status control, drag one of the following items from 

the Specialized list in the Custom View Editor.  
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In the Properties panel, click on the three-dot icon next to Channel Adaptor .

 

Select a Channel Adaptor to link the  control to a Site or a Group.  

To link to a Site, select the Network that contains the Site and the Site you want to link to this control. 

 

To link to a Group, select a Node from the list.  

 

If you check “Automatically set related properties”, the site or group name will automatically populate 

based on the selected item. In the Properties panel, you can specify additional settings that define the 

appearance of the Summary Site Status or Summary Group Status control (such as color mapping for 

alarm levels, caption text, etc.) or you can accept the default settings.  
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Status 

 Arrow LED 

Displays an arrow pointing up, down, left, or right. 

 

 Diamond LED 

A diamond-shaped LED. 

 

 Label LED 

A rectangular LED that includes a caption. The caption changes based on the status condition. 

 

 Label LED (2 Lines Centered) 

A rectangular LED that includes a 2 line caption centered on the object. The caption changes based on 

the status condition. 

 

 Label LED (2 Lines) 

A rectangular LED that includes a 2 line caption. The caption changes based on the status condition. 

 

 Rectangular LED 

A rectangular LED. 

 

 Round LED 

A  round LED. 
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 Status Label 

The status label control displays different labels for "ON" and "OFF". 

 

 Status Line 

A line that changes color based on the status condition. 

 

 Status Panel 

The status panel is used to provide a background that changes color based on status for part or all of 

your Custom View. 

 Status Picture 

The status picture shows one picture when "ON" and another picture when "OFF". 

 Status Sound 

The status sound plays a sound file based on a status condition, as long as the Custom View hosting the 

control is on screen. 

The status sound control does not appear on your Custom View, except in the Custom View Editor. 

Timers 

 Timer Channel 

Displays the value of one of the 64 available timer channels. 

(Available only on the ARC Plus Touch firmware version 5.0.14.1 or greater) 
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Status Conditions 

Available status conditions for the Channel Adapter property of status custom view objects. 

Status Channel A status channel on a remote control unit. 

Raise Relay Active "ON" when the specified raise relay is engaged. 

Lower Relay Active "ON" when the specified lower relay is engaged. 

Macro Running "ON" when the specified macro is running. 

Meter Below Low Critical "ON" when the specified meter is below the second lower limit. 

Meter Below Low Warning "ON" when the specified meter is below the first lower limit. 

Meter Above High Warning "ON" when the specified meter is above the first upper limit. 

Meter Above High Critical "ON" when the specified meter is above the second upper limit. 

Meter Out of Tolerance "ON" when a meter is outside of its "normal" range (above either 
upper limit or below either lower limit). 

Site in Alarm "ON" when the specified site has at least on uncleared alarm. 

Network in Alarm "ON" when any site in the specified network has at least one 
uncleared alarm. 

Site Connected "ON" when the specified site is connected to AutoPilot. 

Site in Maintenance Mode "ON" when the specified site is in maintenance mode (or "Local" mode 
on a GSC3000 or VRC2500). 

Active Flowchart Running “ON” when the specified Jet Active Flowchart is running. 

Virtual Channel “ON” when the specified virtual channel evaluates to true. 

Any Network in Alarm “ON” when any connected site on any network has an alarm 
condition. 

Site Connected On Primary “ON” when the specified site is connected over the primary 
connection. 

Site Connected On Backup “ON” when the specified site is connected over the backup 
connection. 
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Actions 

Available actions for custom view objects with a command adapter property. 

Raise Issues the specified raise command. 

Lower Issues the specified lower command. 

Navigate Opens the specified Custom View in the current window. 

Run Macro Starts the specified macro. 

Stop Macro Stops the specified macro. 

Clear Alarms Clears alarms on the specified site or network. 

Connect Connects to the specified site using the primary connection. 

Disconnect Disconnects from the specified site. 

Run Application Runs the specified command in Windows to launch an 
application. 

Open URL Opens a web browser with the specified URL. 

Print Report Prints the specified report using the default printer. 

Ping Pings the specified Network Device. 

Navigate (New Window) Opens the specified Custom View in a new window. 

Show Default View Opens the Default View for the specified site in the current 
window. 

Show Default View (New 
Window) 

Opens the Default View for the specified site in a new window. 

Run Active Flowchart Runs the specified Jet Active Flowchart. 

Stop Active Flowchart Stops the specified Jet Active Flowchart. 

 

Database Schema 

Note: The onboard database and SQLite Server database use the same schema. 

Directly accessing the onboard database is not recommended. 

Tables 

The following tables are included in the database: 

Table Name Description 

Alarms Stores alarms. 

Events Stores events. 

StatusChanges Stores a record for each time a status channel changed. 

Telemetry Stores a snapshot of meter and status channels for each time AutoPilot takes a 
log. 
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Alarms 

Field Data Type Description 

UTCDateTime Date/Time The date and time of the alarm using UTC time. 

NetworkName String The name of the network on which the alarm occurred. 

UnitName String The name of the site on which the alarm occurred. 

UnitID Integer The unique ID identifying the remote control unit. 

AlarmTypeID Integer Indicates what type of alarm this is: 
 

0 High Limit 
1 Low Limit 
2 Status 
3 System 
4 User 

 

AlarmSeverityID Integer Indicates the severity of the alarm: 
 

-1 Normal 
0 Warning 
1 Critical 

 

ChannelNumber Integer The channel number on which this alarm occurred. This value is 
0 for non-channelized alarms. 

ChannelName String The label of the channel on which this alarm occurred. This value 
is blank for non-channelized alarms. 

AlarmMessage String The message associated with the alarm. 

TimeZoneOffset Integer The time zone offset (number of minutes from UTC) for this site. 

AlarmClass Integer Describes the type of source for the alarm. Used internally by 
AutoPilot. 

SourceIndex Integer Used along with the Alarm Class to uniquely identify the alarm. 
Used internally by AutoPilot. 

UTCInactiveTime Date/Time The time (UTC) when the alarm became inactive. Not applicable 
for incidental alarms or active alarms. 

Disposition Integer The current disposition of the alarm: 
 

0 Incidental 
1 Active 
2 Inactive 

 

Priority Byte The user-defined priority of this alarm. A value of 0 is used when 
no priority is set. 
 
Note: A value of 1 may be either the highest or lowest priority. 
Within AutoPilot, this value is only used for sorting purposes and 
does not otherwise impact functionality. 
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Events 

Field Data Type Description 

UTCDateTime Date/Time The date and time of the event using UTC time. 

NetworkName String The name of the network on which the event occurred. 

UnitName String The name of the site on which the event occurred. 

UnitID Integer The unique ID identifying the remote control unit. 

EventTypeID Integer Describes the type of event. Used internally by AutoPilot. 
 
Note: The values available for this field are numerous and subject 
to change. 
 
Using the field is not recommended. 

EventMessage String Describes the event. 

TimeZoneOffset Integer The time zone offset (number of minutes from UTC) for this site. 

Status Changes 

Field Data Type Description 

UTCDateTime Date/Time The date and time of the status change using UTC time. 

NetworkName String The name of the network on which the status change occurred. 

UnitName String The name of the site on which the status change occurred. 

UnitID Integer The unique ID identifying the remote control unit. 

ChannelNumber Integer The channel number whose status changed. 

StatusValue Boolean The value of the status channel after the change. 

StatusMessage String The status label associated with the new value. 

StatusStateID Integer The alarm state of the status channel: 
 

-1 Normal 
0 Warning 
1 Critical 

 

TimeZoneOffset Integer The time zone offset (number of minutes from UTC) for this site. 
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Telemetry 

Field Data Type Description 

UTCDateTime Date/Time The date and time of the snapshot using UTC time. 

NetworkName String The name of the network on which the snapshot occurred. 

UnitName String The name of the site on which the snapshot occurred. 

UnitID Integer The unique ID identifying the remote control unit. 

ChannelNumber Integer The channel number included in this snapshot. 

ChannelName String The meter label for this channel. 

MeterValue Single The calibrated value of the meter channel. 

Units String The units label for the meter channel. 

AnalogStateID Integer The alarm state of this meter channel: 
 

-1 Normal 
0 Warning 
1 Critical 

 

StatusValue Boolean The value of the status channel. 

StatusMessage String The status label associated with the status value. 

StatusStateID Integer The alarm state of the status channel: 
 

-1 Normal 
0 Warning 
1 Critical 

 

TimeZoneOffset Integer The time zone offset (number of minutes from UTC) for this site. 

 

  



 

120 
 

Jet Actions and Conditions 

Actions 

Alarm (ARC Plus and ARC Solo) Creates a new alarm on the ARC Plus or ARC Solo. 

Clear Alarms (AutoPilot only) Clears all alarms on the selected ARC Plus or ARC Solo. 

Close Custom 
View 

(AutoPilot only) Closes the selected custom view on the AutoPilot computer. 

Decrement Subtracts 1 from the specified memory variable. 

Email Report (ARC Plus and ARC Solo) Emails a report using a template. 

Increment Adds 1 to the specified memory variable. 

Log Message (AutoPilot only) Adds the specified message to the Event Log on the selected 
ARC Plus or ARC Solo. 

Lower Issues a Lower command for the specified channel. 

Message (ARC Plus and ARC Solo) Adds the specified message to the unit’s  Event Log. 

Open Custom 
View 

(AutoPilot only) Opens the selected custom view on the AutoPilot computer. 

Raise Issues a Raise command for the specified channel. 

Reset Timer (ARC Plus firmware 5.0.14.1 or greater) Resets one of the 64 independent 
timers on the selected site. 

Send Email Sends an email message. 

Set (ARC Plus only) Sets a meter channel value, a status channel value or a 
memory value. 

Set Flowchart (AutoPilot only) Starts or stops a flowchart. 

Set Limit (ARC Plus and ARC Solo) Sets a meter limit to the specified value. 

Set Macro Starts or stops a macro. 

Set Memory Sets a memory variable to the specified value. 

Set Mute (ARC Plus and ARC Solo) Mutes or unmutes a channel. 

Speak Phrase (ARC Plus and ARC Solo) Causes the ESI/RSI to speak the specified phrase 
when configured for audio output. 

Start Timer (ARC Plus firmware 5.0.14.1 or greater) Starts one of the  64 independent 
timers on the selected site. 

Stop Timer (ARC Plus firmware 5.0.14.1 or greater) Stops one of the 64 independent timers 
on the selected site. 

Take Capture (ARC Plus only) Captures channel values locally on the ARC Plus. 

Take Log (AutoPilot only) Logs the specified site. 

Wait Pauses the flowchart for the specified duration. 
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Conditions 

If Evaluates a meter, status or memory variable to a specified constant. 

If Alarm Evaluates the number of alarms on the specified site. 

If Calendar Time Determines if the current time matches the specified calendar time. 

If Date Determines if the current date matches the specified date. 

If Day Determines if the current weekday matches the specified weekday. 

If Flowchart (AutoPilot only) Evaluates the state of the specified flowchart. 

If Macro Evaluates the state of the specified macro. 

If Maint mode Determines if a site is in maintenance mode. 

If Memory Evaluates the specified memory variable. 

If New Status Evaluates a status channel after waiting for a new reading. 

If New Value Evaluates a meter channel after waiting for a new reading. 

If Relay State Evaluates the relay state of the specified channel. 

If Status Evaluates the specified status channel. 

If Time Determines if the current time matches the specified time. 

If Value Evaluates the specified meter channel. 

 

Virtual Channel Syntax 

Operators and Constants 

+ Addition 

- Subtraction 

* Multiplication 

/ Division 

Mod Modulo 

Pi The constant Pi (π) 

E The constant e 

= Equals 

< Less than 

> Greater than 

<= Less than or equal 

>= Greater than or equal 

<> Not equal 

( Open paren 

) Close paren 

And Logical and 

Or Logical or 

Not Logical not 

Xor Logical exclusive or 

True The constant true 

False The constant false 
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Functions 

Site Functions 

Meter  Returns the value of a meter channel.  

Status  Returns the value of a status channel.  

RelayRaised  Returns true if the command channel is raised.  

RelayLowered  Returns true if the command channel is lowered.  

InAlarm  Returns true if the site is in alarm.  

MaintMode  Returns true if the site is in maintenance (local) mode.  

 

Jet 

MemoryVariable  Returns the value of a flowhcart memory variable.  

VirtualMeter  Returns the value of a virtual meter channel.  

VirtualStatus  Returns the value of a virtual status channel.  

 

Math and Logic Functions 

Abs  Absolute value  

Acos  Arccosine  

Asin  Arcsine  

Atan  Arctangent  

Atan2  Arctangent (angle from the x-axis to the specified point 

Ceiling  Returns the smallest integer greater than or equal to the specified number.  

Cos  Cosine  

Exp  Returns the constant e raised to a power.  

Floor  Returns the greatest integer less than or equal to the specified number.  

Iff  Evaluates a condition and returns one value if true and the other if false. 

Log  Returns the log of a number using the specified base.  

Log10  Log base 10  

Max  Returns the largest value from a list.  

Min  Returns the smallest value from a list.  

Ln  Natural log  

Pow  Returns the value of a number raised to a specified power.  

Round  Returns a number rounded to the nearest integer.  

Sin  Sine  

Sqrt  Square root  

Tan  Tangent  
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Date/Time Functions 

Now  The current date and time.  

Weekday  The current weekday.  

Today  The current date.  

Sunday  The constant value for Sunday.  

Monday  The constant value for Monday.  

Tuesday  The constant value for Tuesday.  

Wednesday  The constant value for Wednesday.  

Thursday  The constant value for Thursday.  

Friday  The constant value for Friday.  

Saturday  The constant value for Saturday.  

 

Calendar Functions 

PreSunrise  Returns the date/time for Pre-Sunrise for the current month. 

Sunrise  Returns the date/time for Sunrise for the current month.  

Sunset  Returns the date/time for Sunset for the current month.  

PostSunset  Returns the date/time for Post-Sunset for the current month.  

User1  Returns the date/time for User 1 for the current month.  

User2  Returns the date/time for User 2 for the current month. 
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Appendix A – Notes for AutoPilot 3 Users 

AutoPilot will wait for all channel values before completing a connection.  

When you connect to an ARC-16 in AutoPilot, the software now waits until it has received a value for 

every channel. By doing so, it will never display "NO DATA" for a meter channel.  

ARC-16 "Groups" are now ARC-16 "Networks"  

You no longer need to create ARC-16 "Groups" as a separate step in setup. You now add a "Network" of 

ARC-16s, which will automatically load the parent and child sites including in the network.  

Configuring connections is no longer a separate process.  

Configuring connections is now part of site setup (SEE ADDING ARC-16 NETWORKS, PAGE 23). AutoPilot 

allows you to configure two connections for each ARC-16 Network – primary and backup.  

You no longer need to write a script/macro to restore a lost connection or switch to a backup.  

AutoPilot now automatically restores a connection if it has been dropped. If you configure a backup 

connection for your network, AutoPilot will automatically switch to the backup should the primary 

become unavailable.  

"Alarm History" and "Active Alarms" are now both found in the Alarm List.  

All ARC-16 alarms are included in the Alarm List. Cleared and inactive alarms are differentiated by icon 

color. To view a list of older alarms, use Log View.  

Charting is now part of Custom Views  

Charts are now part of Custom Views, and are configured directly in the Custom View Editor.  

AutoPilot does not require individual accounts for each user.  

You no longer need to create accounts for each person who will use AutoPilot. For security, you can 

configure your sites to require password entry before connecting (SEE ADDING ARC-16 NETWORKS, 

PAGE 23), and you can require a password to unlock the configuration options in AutoPilot (SEE 

SECURITY, PAGE 83).  

Scripts and Macros are now part of Jet™.  

Jet uses a simple flowchart interface to design automatic functionality, replacing the VBS scripting and 

Macros used in previous versions.  

Jet Active Flowcharts do not require you to connect/disconnect specific sites or test for a connection.  

Jet will automatically connect to any sites that an Active Flowchart requires, and will disconnect when it 

longer needs that site. You do not need to manually connect/disconnect in your flowcharts, nor do you 

need to test for connection status. 
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Appendix B – Notes for Lynx 5 Users 

AutoPilot does not require software activation.  

AutoPilot uses a different licensing model than Lynx, and no longer requires activation. There is no 

restriction to how many computers you can install AutoPilot on.  

Site configuration is now part of AutoLoad GSC.  

To configure your GSC3000, VRC25000, Voice Interface, or G-Link™ unit, use AutoLoad GSC. See 

www.burk.com for more information.  

Voice Interface units are not displayed in AutoPilot.  

Because your Voice Interface does not have any channels, it is not displayed in AutoPilot.  

AutoPilot only downloads the parts of your configuration that it needs.  

You may notice that AutoPilot does not download all of your site configuration when it connects. To 

improve performance, AutoPilot only downloads the parts of the configuration that it needs.  

AutoPilot will automatically restore a dropped connection to your site.  

You no longer need to specifically configure the software to reconnect to a site after a link loss. 

AutoPilot will do so automatically.  

AutoPilot can automatically "tune" your connection settings to optimize performance.  

By default, AutoPilot will automatically adjust your site's connection settings to optimize 

communications performance (SEE ADDING GSC3000/VRC2500 SITES, PAGE 28). When this feature is 

enabled, AutoPilot will increase and decrease timeout durations based on actual response times. If 

desired, you can still set these parameters manually.  

Charting is now part of Custom Views  

Charts are now part of Custom Views, and are configured directly in the Custom View Editor. 


